RE N ESAS Application Note

Renesas RA Family

GUIX Hello World for EK-RA8D1 MIPI LCD Display

Introduction

This application note describes the process of creating a simple two-screen GUI using Azure RTOS GUIX
Studio for the EK-RA8D1 kit. This application demonstrates how easily a user can create and configure a

new application using the Renesas Flexible Software Package (FSP).

The Renesas Flexible Software Package includes Azure RTOS ThreadX® real-time operating system, the
Azure RTOS GUIX library and hardware drivers are unified under a single robust software package. This

powerful suite of tools provides a comprehensive integrated framework for rapid development of complex

embedded applications.

Required Resources
Development tools and software

e e?studio IDE Version: 2023-10 (23.10.0) or greater
e Renesas Flexible Software Package (FSP) v5.1.0 or greater
e Azure RTOS GUIX Studio V6.3.0.1 or greater

Hardware

o Renesas EK-RA8D1 kit (RA8D1 MCU Group)
¢ Renesas EK-RA8D1’s “SW1” switches setting.
— Switch #6 for GLCDC set “ON”, switch #7 for SDRAM set “ON” and all the other switches set “OFF”.

Reference

RA Flexible Software Package Documentation Release v5.1.0
Azure RTOS GUIX and GUIX Studio v6.3.0.1

Renesas RA8D1 Group User's Manual Rev.1.1.0
EK-RA8D1-v1.0 Schematics

Provided Software Files

e A sSource.zip folderthathas 2 touch gt911 and SEGGER_RTT folders and 4 *.c with 2 *.h files
inside

e hal entry.c,system thread entry.c, touch thread entry.c,windows handler.c
system thread entry.h, common utils.h

Purpose

This document will guide you through the setup of an Azure RTOS GUIX touch screen interface Hello World
application in e? studio. This document will show how to configure the drivers and library included with the
FSP. The instructions in this document will allow you to set up the MIPI Display Controller, the touch screen
driver, and semaphores to communicate with application tasks. It also shows the steps necessary to create a
simple GUI interface using the Azure RTOS GUIX Studio editor. In addition, this app note will also cover
project setup along with basic debugging operations. When it is running, the application will respond to
touchscreen actions, presenting a basic graphical user interface (GUI).

Intended Audience

The intended audience is users who want to design GUI applications.
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1. Downloading and Installing Tools

1.1 Overview

In this section you will copy materials to your PC and install the required software: e? studio v2023-10.0 with
FSP v5.1.0, and Azure RTOS GUIX studio v6.3.0.1.

1.2 Procedural Steps

1. If you already have e? studio v2023-10 with FSP v5.1.0 or later installed, you can skip this step.

Otherwise, you can download it from https://www.renesas.com/us/en/software-tool/flexible-software-
package-fsp.
Detailed installation instructions for the e2 studio and the FSP are available on the Renesas website
https://www.renesas.com/fsp. Review the release notes for e2 studio to ensure that the e2 studio version
supports the selected FSP version. The starting version of the installer includes all features of the RA
MCUs.

2. You can get Azure RTOS GUIX Studio v6.3.0.1 or greater from this link.

You should see the window in the next step on the web browser.
Note: Microsoft Store must be working on your PC to install Azure RTOS GUIX studio.

3. Click Install Button and New window popup. Click Open Microsoft Store.

v = X
B Azure RTOS GUIX Studio - Mi X + =
< & @ apps.microsoft.com/detail/azure-rtos-guix-studio/9PBM1K1R7QOF ?rtc = 1&activetab=pivot%3Aoverviewtab&hl=en-us8gl=us |& ¢ m » 0O 2 @
@l Tracking_Kits_List Il Tracking_MCUs_List € Renesas Intranet [} Renesas Gallery @ 10T Systems - Home M Group Meeting fB® Renesas Create Rap... » All Bookmarks

= Microsoft | Store Home Apps Games Movies & TV 1, Search apps, games, movie B Open Store app

Azure RTOS GUIX Studio

Microsoft Corporation

50% 2ratings Developer tools

Install (7

Figure 1. Get Azure RTOS GUIX Studio
4. Click Open Microsoft store to continue installing Azure RTOS GUIX Studio.

Open Microsoft Store?

https://apps.microsoft.com wants to open this application.

[J Always allow apps.microsoft.com to open links of this type in the associated app

Open Microsoft Store I

Figure 2. Open Microsoft Store
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Renesas RA Family GUIX Hello World for EK-RA8D1 MIPI LCD Display
5. Click Open to open the “Azure RTOS GUIX Studio” App.

a Microsoft Store X

)( Azure RTOS GUIX Studio

5.0 & (Z Privacy 8&terms (7 More details

€] covon

}GI Azure RTOS GUIX Studio 6.3.0.0 - O X
Project Edit Insert Configure Help
O & B ¥ & 6 2 3 7 L £ w2 B G dIag& Kk X @

Figure 3. Click Open to start “Azure RTOS GUIX Studio”.
2. Create Application Note Project and Enabled Backlight
2.1 Overview

In this section, you will create a project to which you will add pre-written source code and integrate it with a
pre-created Azure RTOS GUIX studio project.
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2.2 Procedural Steps
1. Create a new Renesas RA C/C++ project. Name it mipi_ek_ra8d1_guix_hello_world.

& Renesas RA C/C++ Project O X

Renesas RA C/C++ Project —

Project Name and Location

Project name

I mipi_ek_ra8d1_guix_hello_world I

Use default location
C:\WorkSpace\EK_RA8D1\mipi_ek_ra8d1_guix_hello_world Browse...

You can download more Renesas packs here

'7/' < Back Next > Einish Cancel

Figure 4. Create New Project
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2. Select and set board to EK-RA8D1.

@ Renesas RA C/C++ Project

Renesas RA C/C++ Project

Device and Tools Selection

Device Selection

Board Description

FSP Version:|/5.1.0 e
; Evaluation kit for RA8D1 MCU Group
Board: EK-RA8BD1 PV
Visit TBD to get kit user's manual, quick start guide,
Device: R7FA8D1BHECBD errata, design package, example projects, etc.
Core: CM85
®c O Device Details
Language: € C++
e TrustZone Yes
Pins 224
Processor Cortex-M85
Toolchains Debugger
GNU ARM Embedded J-Link ARM ¥

LLVM Embedded Toolchain for Arm

13.2.1.arm-13-7 b

)

Figure 5. Select and Set board to EK-RA8D1
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3. Select Flat (Non-TrustZone) and Executable with Azure RTOS ThreadX (v6.2.1+FSP.5.1.0).

a Renesas RA C/C++ Project

Renesas RA C/C++ Project

Project Type Selection

Project Type Selection

(® Flat (Non-TrustZone) Project

® Renesas RA device project without TrustZone
separation

® All code, data and peripheral settings will be
configured in this project

* Renesas RA device will remain in secure mode

® EDMAC RAM buffers will automatically be placed
in non-secure RAM

(O TrustZone Secure Project

® Renesas RA device project for TrustZone secure
execution

® All code, data and peripherals placed in this
project will be initialized as secure

® Secure project settings such as TrustZone
partitions, linker maps and a list of secure
peripherals will be passed to a selected non-
secure project

® After initialization, a call to the non-secure startup
handler will be made

(O TrustZone Non-secure Project

® Renesas RA device project for TrustZone non-
secure execution

® All code, data and peripherals placed in this
project will be initialized as non-secure

® Must be associated with a secure project or smart
bundle

#* Non-secure startup handler will be called after
secure code initialization

O X

‘\?‘ Next > FEinish Cancel
a Renesas RA C/C++ Project O X
Renesas RA C/C++ Project B —
Build Artifact and RTOS Selection
Build Artifact Selection RTOS Selection
(® Executable I;Azure RTOS ThreadX (v6.2.1+fsp.5.1.0) o I
® Project builds to an executable file
(O static Library
® Project builds to a static library file
(O Executable Using an RA Static Library
® Project builds to an executable file
® Project uses an existing RA static library project
< Back Finish Cancel

Figure 6. Select Azure RTOS ThreadX
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Renesas RA Family GUIX Hello World for EK-RA8D1 MIPI LCD Display
4. Use Azure RTOS ThreadX — Minimal template.

Q Renesas RA C/C++ Project O X

Renesas RA C/C++ Project

Project Template Selection

Project Template Selection

O " Azure RTOS ThreadX - Blinky

©

Azure RTOS ThreadX project that includes BSP and will blink LEDs if available. This project will
initialize the MCU using the BSP. ThreadX will also be initialized and a single thread to blink the
LEDs will be started.

[Renesas.RA.5.1.0.pack]

® (}' Azure RTOS ThreadX - Minimal

Empty ThreadX FSP project with no threads. This project will initialize the MCU using the BSP.
[Renesas.RA.5.1.0.pack]

Code Generation Settings

Use Renesas Code Formatter

@ _<Beck || Ned> Cancel
Figure 7. Select Minimal Template
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5. Open the project configuration, by double clicking the configuration.xml
changing the e? studio view to FSP Configuration. Go to the BSP tab and select the Properties tab.
Here, change Main stack size (bytes) and Heap size (bytes) to 0x2000.

4or configuration.xml

file and

2 *Imipi_ek ra8d1_guix_hello_world] FSP Configuration X

Board Support Package Configuration

[ Restore Defaults

Device Selection

Board Details

= O || properties X

EK-RA8SD1

Generate Project Content

Settings

Property

OFS2 register settings

Block Protection Settings (8PS)
Permanent Block Protection Settings (PBPS)

First Stage Bootloader (FSBL}
Clocks

Cache settings

Dual Bank Mode

Main Oscillator Wait Time

v RA Common

FSP version: |5.1.0 ~

Evaluation kit for RA8D1 MCU Group
Board: EK-RA8D1 > | B

Visit TBD to get kit user's manual, quick start guide,
Device:  RTFABDIBHECED Bl | cvate. design package, example projects, etc
Core: CM8s5
RTOS: Azure RTOS ThreadX

locks | Pins Interrupts | Event Links Stacks | Components

Value

Disabled
8163 cydles

Main stack size (bytes)
Heap size (bytes)

0x2000
0x2000

MCU Ve (mV)
Parameter checking
Assert Failures
Error Log

Clock Registers not Reset Values during Startup

Main Oscillator Populated
PFS Protect

Early BSP Initialization
Main Oscillator Clock Source
Subdock Populated

Subdlack Drive (Drive capacitance availability varies by MCU)

Subclock Stabilization Time {ms)

3300

Disabled

Return FSP_ERR_ASSERTION
No Error Log

Disabled

Populated

Enabled

Enabled

Disabled

Crystal or Resonater
Populated
Standard/Normal mode
1000

Figure 8. Change Heap Size
6. Click the Clocks tab and set the LCDCLK Source Input to PLL1P.

8 EK_RABD1 - mipi_ek_ra8cl1_guix hello_werld/configuration xml - o studio
Ele Edit Source Refactor Navigate Search Project Renesas Miews Bun Renesas Al Window Help
K~ B b | v Q-

mipi_ck_ra8d1_guix_hello_world] FSP Configuration < system_thread_entry.c

[8) startupc  [£) mainc

' Clocks Configuration

XTAL 20MHz
1*vLL Src: XTAL ~
HOCO 48MHz b PLL Div /1 ‘L -, PLL1P Div /2 ~ —>PLLIP 480MHz
LOCO 32768Hz PLL Mul %48.00 > prPLLIQDW /2 ~ —>PLLIQ 480MHz
MOCO BMHz PLL 960MH:z PLL1R Div /2 » —PLLIR 480MHz
SUBCLK 32768Hz PLL2 Disabled v
PLL? Div /1 % PLL2P Div /2 v —>PLL2P 0Hz
PLL2 Mul x48.00 > PLL2Q Div /2 v —>PLL2Q OHz
PLL2 OHz PLL2R Div /2 v —>PLL2R OHz

Summary | BsP} ins  Interrupts| Event Links Stacks| Components

9 touch_thread_entry.c

¢® Clock Sre PLLTP

CLKOUT Disabled

SCICLK Disabled

SPICLK Disabled

CANFDCLK Disabled

£ touch_gt911.c

h| touch_gt911.h

~ =2 CPUCLK Div /1

[|ICLK Div /2

[ PCLKA Div /4

[ PCLKB Div /8

[ PCLKC Div /8

[ PCLKD Div /4

[>{PCLKE Div /2

SDCLK Enabled

[*|BCLK Div /4

EBCLK Div /2

> FCLK Div /8

~ =2 CLKOUT Div /1

~ —> SCICLK Div /4

~ —> SPICLK Div /4

~ —> CANFDCLK Div /8

£ common datac

~ —> CPUCLK 480MHz

~ —>/[CLK 240MHz

» —> PCLKA 120MHz

~ — PCLKB 60MHz

w —>|PCLKC 60MHz

~ —> PCLKD 120MHz

~ —>|PCLKE 240MHz

~ —>5DCLK 120MHz

~ —>{BCLK 120MHz

~ —> EBCLK 60MHz

~ —>{FCLK 60MHz

~ —>|CLKOUT OHz

~ —>/SCICLK OHz

~ —> SPICLK OHz

~ —> CANFDCLK OHz

> LCDCLK Src PLLIP

~ —LCDCLK Div /2

« —>LCOCLK 240Mz

I3CCIK Disabled

UCK Disabled

UBOCK Disabled

OCTASPICLK Disabled

~ —>13CCIK Div /3

~ —3UCK Div /5

~ —> UG0CK Div /5

~ —> OCTASPICLK Div /4

~ —>13CCLK 0Hz

¥ —>UCK 0Hz

~ —>|UGOCK OHz

~ — OCTASPICLK OHz

Q | E@oces 15 Debug

=5

ba

Generate Project Content

[T

&

I Restore Defaults

~

D

[}

Figure 9.

Enabling the LCD Clock to PLL1P
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7. Go to the Stacks tab to view the current project’s threads and modules. Add a New Thread and name it
as System Thread with the Property settings shown below.

¢ *[mipi_ek ra8d1_guix_hello_world] FSP Configuration = 0| @ Properties >C
: 0
Stacks co"ﬁguratlon Generate Project Content Desliwess
Settings Property Value
Threads % | New Thread ® | Remove —| % | New Stack > v Common
System Thread Stacks
General
v o HAUCommon T
& g_ioport 1/0 Port (r_ioport) ‘0 Add stacks to the selected thread by using the 'New Tae
& Azure RTOS ThreadX Port (rm_threadx_port) L¥  Stack' toolbar button (above), or by pasting here P Te—
& System Thread from the dipboard. RA
Interrupts
~ Thread
Symbol system_thread
Name System Thread
Objects %] New Object > Stack size (bytes) 8192
Priority 5
Auto start Enabled
Time slicing interval (ticks) 0

Summary BSP | Clocks | Pins  Interrupts | Event Links Componen(s

Figure 10. Add System Thread

8. Make sure the System Thread is highlighted in the Threads window. Click “New Stack” and add
Graphics > Azure RTOS GUIX to System thread.

5% *[ra8d1_guix_hello_world] FSP Configuration X = O [ properties X
Stacks Configuration o System Thread

Generate Project Content
Settings Property

Thread % | New Thread # | Rei = ¢ | New Stack ~ Common
reads ¢ | New Thread # | Remove - Thread Stacks Lo New Stack >

v % HAL/Common . Aﬂ.ﬂ|-0.g . ’ cenenl
» Artificial Intelligence > Timer
& g_ioport I/0 Port (_ioport) ‘o Add stacks to the selected thre Andio 5 =
@ Azure RTOS ThreadX Port (rm_threadx_port) = to.olbar button (above), or by T e > P ——
& System Thread dipboard. Cornastiity ) RA
DSP N Interrupts
|  Graphics > & Azure RTOS GUIX
Input > @ Capture Engine Unit (r_ceu)
Monitoring > 4 D/AVE 2D (r_dw)
Maton > @ D/AVE 2D Port Interface (r_drw)
Networking > P Graphics LCD (r_gledc)
Power > Time slicing interval (tic
Security >
Sensor &
Storage z
System >
Timers >
Transfer >
Objects % | New Object > = .
‘ : ¥ Search...
Figure 11. Add Azure RTOS GUIX
R12AN0134EUO0100 Rev.1.00 Page 10 of 63
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9. Settings properties for Azure RTOS GUIX (rm_guix_port) and GLCDC Display.

_ii’v,} *[mipi_ek_ra8d1_guix_hello_world] FSP Configuration > ‘ =HE =] Properties X

Stacks Configuration - Azure RTOS GUIX Port (rm_guix_port)
Generate Project Content
— . : = . Settings Property Value
Threads % | New Thread # | Remove = System Thread Stacks 4 | New Stack > == o0 Cick © %] Remove APLInk ¥ Common
nfo

DRW Buffer Cache Enabled
+ Module Azure RTOS GUIX Port (rm_guix_port)
~ Display Rotation

~ & HAL/Common
4 g_ioport 1/O Port (r_ioport)
& Azure RTOS ThreadX Port (rm_threadx_port)

4 Azure RTOS GUIX

Screen Orientation None
v & System Thread Use Canvas Buffer Disabled
# Azure RTOS GUIX Canvas Buffer Memory Section
v JPEG Decoding

Work Buffer Size 0xC800
Buffer Memory Section

Name g_rm_guix_port0

Target Display Layer Graphics Layer 1

Callback Function NULL

4 g display0 Graphics LCD
(r_gledg)

©)

4 D/AVE 2D Port Interface
(r_drw)

@

A

A

%% Add MIPI DSI Output

& D/AVE 2D (r_drw)

(Optional)

@

Objects %] New Object > 5| Remcy

Figure 12. Setting and checking Properties for Hardware
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10. Settings properties for Graphics LCD

¥ [mipi_ek_ra8.. X

|€] system_threa... L€ startup.c
Stacks Configuration
Threads % | New Thread l_l_J Remove -/

v % HAL/Common
& g_ioport I/O Port (r_ioport)
4 Azure RTOS ThreadX Port (rm_threadx_port)

w {§# System Thread
4% Azure RTOS GUIX

L] main.c \£] common_data.c ”3 =B
0
Generate Project Content
& | New Stack > == [»
System Thread Stacks =
% | Remove
4 Azure RTOS GUIX
@
a

4 Azure RTOS GUIX Port (rm_guix_port)

47 D/AVE 2D Port Interface
(r_drw)

(©)

il T
% Add MIPI DSI Output 4% D/AVE 2D (r_dw)
(Optional)
Objects € | New Object >
®
[ Properties X ‘ (g system_thread_entry.c‘
g_display Graphics LCD (r_gledc)
Settings Property Value Property Value
——— 7 v Common » Common
m v Module g_display Graphics LCD (r_gledc) v Module g_display Graphics LCD (r_glcdc)
v General > General
Name > Interrupts
> Interrupts Input
¥ Input ~ Output
v Graphics Layer 1 ~ Timing
v General Horizontal total cycles 559
Enabled Yes Horizontal active video cycles 480
Horizontal size 480 Horizontal back porch cycles 5
Vertical size 854 Horizontal sync signal cycles 2
Horizontal position 0 Horizontal sync signal polarity Low active
Vertical position 0 Vertical total lines 894
Color format Vertical active video lines 854
Line descending mode Disabled Vertical back porch lines 20
» Background Color Vertical sync signal lines 3
» Framebuffer Vertical sync signal polarity Low active
» Line Repeat Data Enable Signal Polarity High active
> Fading Sync edge
> Graphics Layer 2 > Format
> Output > Background
> CLUT > CLUT
> TCON TCON
» Color Correction » Color Correction
> Dithering > Dithering

Figure 13. Setting Properties for GLCDC DISPLAY
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Renesas RA Family GUIX Hello World for EK-RA8D1 MIPI LCD Display

11. Add the MIPI DSI Output by clicking on the “Add” option attached to the r_glcdc stack, and fill out the
settings properties for MIPI Graphics LCD (r_mipi_dsi) module based on the following image:
Note: All the other settings are set to the default value for the LCD pixel 480x854 so the details are not
shown here.

45} [mipi_ek raBd1_guix_hello_world] FSP Configuration % =g = B || properties X £ Outline|
g o o i sl i ini. dsil
Stacks Configuration Generate Projact Contant Genarate Project Content Srnipl claiy bt Disptay, (7 miplidsl)
: . - Settings  ProPErty Value
Threads Sl New Threod WlRemove 1\ i stacks ) e Stack > = o Stacks & New Stack > R LO:\I’\OH )
v o HALXCommon 1 % fheac %] Remove arameter Checking Defoult (85P)
* ~ Moduke g_mipi_dsi0 MIPI Display (r_mipi_dsi)
& g ioport O Port (r_iopert) = = s
@ Ao FIOS Theoad Poct (on i readx posl & Anure RTOS GUIX & Anwe RTOS GUIX —
v @ f:yst?m Thread Low Power
& Azure RTOS GUIX @ ® > Clock Lane
o S Data Lane
= 1 = L Video Mode
@ Azure RTOS GUIX Port {rm guix port) & Azwe RTOS GUIX Port {rm_guix_port) w Inkastighs
Receive Interrupt Friable
Fatal Error Interrupt Enable
(D (D Physical Lane Interrupt Enable
L - r T - - video Mods Interrupt Enable
& g _display Graphics LCD & D7avE 20 Port Interface & g_display Graphics LCD & D/AVE 2D Port Interface Sequence Channel 0 Interrupt Enable
(r_gledc) r_drw) {rgkcdc) {r.drw) Sequence Channel 1 Interrupt Enable
disi_seq0 Interrupt Priority Priority 12
[0} @ @ ) dsi_seq1 Intermupt Priarity Pricrity 12
=y T ~ dsi_vin1 Interrupt Priority Priotity 12
= dsi rcv Internupt Priority Priority 12
& D/AVE 20 (1 drw) 2 & D/AVE 2D (1_diw) dsi_ferr Intarrupt Priority Priorty 12
dsi_ppi Internupt Priority Priority 12
ot
Objects &) New Object > @ i @ Calloack Context NULL
ry

T New > b MipiDisplay (cmipics) |

@ g_mipi_phy0 MIPI
Physical Layer
(r_mipi_phy)

@

Figure 14. Adding and Setting Properties for MIPI Graphic LCD

12. Click “New Stack” and add Timers > PWM Timer (r_gpt).

¢ [ra8d1_guix_hello_world] FSP Configuration X = a|(| Properties X
: o
Stacks Conﬁguratlon Generate Project Content S R
Settings Property
Threads % New Thread M| Remove - System Thread Stacks ;{ x] v Common
v & HAL/Common Analog > General
® . & Azure RTOS GUIX Avrtificial Intelligence > Timer
% g_ioport I/O Port (r_ioport) § T
4 Azure RTOS ThreadX Port (rm_threadx_port) Aldio & R —
S ® antloat-ieir > =
¥ Azure RTOS GUIX n e atiD 2 » Interrupts
= L 2l § 4 v Thread
4 Azure RTOS GUIX Port (rm_guix_port) Graphics > Symbol
Input > Name
Monitoring 4 Stack size (bytes)
® Motor > Priority
T - N king > Auto start
4 g_display0 Graphics LCD 4 D/A  Power > Time slicing interval (ticks)
(r_glcdc) (r_di Security >
Sensor e
@ @ Storage >
f System >
%7 Add MIPI DSI Qutput 4 o/ Timers > |4 Port Output Enable for GPT (r_poeg)
. : (Optional) Transfer > @ Realtime Clock (r_rtc)
LD o B 4 Search.. 4 Three-Phase PWM (r_gpt_three_phase)
@ | [ETimer. General Pt (- gpt
I 4 Timer, Low-Power (r_agt)
4 Timer, Ultra-Low-Power (r_ulpt)

Figure 15. Add the Timer
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Renesas RA Family GUIX Hello World for EK-RA8D1 MIPI LCD Display

13. Set the Timer, General PWM (r_gpt) module properties as shown below

2% *[mipi_ek_ra8d1_guix_hello_world] FSP Configuration X 5 = [T Properties
. 0o =2 =

imer0 Timer, General PWM (r_gpt|

Stacks co“ﬁgumtlon Generate Project Content e (r-gpt)

Settings Property Value
Threads % | New Thread ®_| Remove (- g_timer0 Timer, General PWM ¢ New Stack > APLInfo ~ Common
v 2% HAL/Common (r_gpt) Stacks £ Exdend Stack > %] Remove — Parameter Checking Default (85P)
& st Pin Output Support
gopore|/0 ot oport Wiite Protect Enable Disabled

& Azure RTOS ThreadX Port (rm_threadx_port)

~ Module g_timer0 Timer, General PWM (r_gpt)
v @ System Thread

v General
4 Azure RTOS GUIX Naha
4 g_timer0 Timer, General PWM (r_gpt) Channel
Mode Periodic
Period 0x10000
Period Unit Raw Counts
> Output
> Input
¥ Interrupts
Callback
Overflow/Crest Interrupt Priority
Capture A Interrupt Priority Disabled
Capture B Interrupt Priority Disabled
Underflow/Trough Interrupt Priority Disabled
> Extra Features
¥ Pins
GTIOCOA <unavailable>
GTIOC0B <unavailable>

Objects 4] New Object > x

Figure 16. Settings Timer properties
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Renesas RA Family

GUIX Hello World for EK-RA8D1 MIPI LCD Display

14. Now we will set the output pins for the project. Navigate to the Pins tab. Configure pin P404, the
DISP_BLEN signal of the LCD panel, and set the Mode to Output mode (Initial High).

Pin Configuration

Select Pin Configuration

| RABD1T EK

w0 [mipi_ek ra8d1_guix_hello_world] FSP Configuration

= 8
o

Generate Project Content

__5-} Export to CSV file E Configure Pin Driver Warnings

v ‘ Manage configurations...

Generate data: | g_bsp_pin_cfg |

Pin Selection = [+

- 1%

| Type filter text

v P401
v P402
7 P403

7 P405
v P406
v P407
# P408
¥ P409
¥ P410
v PA11
v P412
v P413
¥ P414
¥ P415
v P5

Yl

<

“ P404

~

Pin Function | Pin Number

Pin Configuration

.} Cyde Pin Group

Name
Symbolic Name
Comment
Mode
Pull up/down
IRQ
Qutput Type
Drive Capacity
v Input/Output
P404

Value
DISP_BLEN

Qutput mode (Initial High)

None
None
CMOS
L

v GPIO

Link

<

Module name:

Port Capabilities:

P404

CEU: VIO_D3
ETHER_MII: ETO_EXOUT

FTILIFD DAAIL. CTA CWALIT

Summary | BSP | Clocks Pins| Interrupts | Event Links | Stacks | Components

Figure 17. Settings pin P404 for DISP_BLEN
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Renesas RA Family

15. LCD_BLEN pin from the LCD panel will connect to DISP_BLEN pin P404 of the board RA8D1

2B1<

BACKLIGHT DRIVER

IN

a.0v :%Lmzazsczmzzom 1
u
- LEDA @ 2B6<
LB LED Backlight
I%QTSMMTMZ-T g If = 40mA typ
=1 V=128V
2 [N X8 En 41E|E|TP14 P
vouT 7
=  reswl__6 LEDK 288>
P404 3 PWWEN R <H]
DISP_BLEN 2 oFBl 5 ory o
O =
5

9
1

2200 ! =
nc

Figure 18. LCD_BLEN will connect to DISP_BLEN pin P404

16. Referto “system thread entry.c”file in “Source.zip” folder for more information on what the
system thread does. This function shown below controls the PWM output.

/* Initialize GPT module */
err = R_GPT_Open(&g_timer_ PWM_ctrl, &g_timer PWM_cfg);

/* Handle error */
handle_error(err, "** R_GPT_Open API failed ** \r\n");

/* Enable GPT Timer */
err = R_GPT_Enable(&g_timer_ PWM_ctrl);

/* Start GPT timer */
err = R_GPT_Start(&g_timer_PWM_ctrl);

Figure 19. gpt_timer_PWM function located in “system_thread_entry.c”
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3. Add and Configure the gt911 Touch Driver

1. Click “New Thread” and name “Touch Thread” with setting as shown below.

15 *[mipi_ek_ra8d1_guix_hello_world] FSP Configu... X ;€ startup.c L€ main.c Le] touch_thread_entry.c = 0| [® Properties X | Lg| system_thread _entry.c
: o T
ouch Thread
Stacks Conﬁguratlon Generate Project Content
Settings Property Value
Threads % | New Thread % |Remove |- % | New Stack > ¥ Common
Touch Thread Stacks
" General
v m' HAL/Common Timer
47 g_ioport I/0 Port (r_ioport) ‘0' Add stacks to the selected thread by using the 'New Trace
@ Azure RTOS ThreadX Port (rm _threadx_port) ¥’ Stack’ toolbar button (above), or by pasting here from A i —
v @ System Thread the dlipboard. RA
4 Azure RTOS GUIX
Interrupts
P g timer PWM Timer, General PWM (r_gpt) v Thread
Touch Thread Symbol touch_thread
Name Touch Thread
Stack size (bytes) 4096
Priority 3
< > Auto start Enabled
Time slicing interval (ticks) 0

Objects % | New Object >

Summary | BSP Clocks Pins | Interrupts | Event Links Stacks | Components

Figure 20. Add and Set Touch Thread Properties

2. From Threads window, select HAL/Common and click “New Stack” and add Input > External IRQ
(r_icu) module.

£5¢ *[ra8d1_guix_hello_world] FSP Configuration X = 0|8 Properties X

o

Stacks Conﬁguratlon Generate Project Content

Properties are not availal

Threads % | New Thread % | Remove - Touch Thread Stacks
) - Anal >
v o HAUCOI’HI’I"IO!‘II 0 Add stacks to the selected thread by using tl n? og .
T g_ioport I/O Port (r_ioport) J (above), or by pasting here from the dipboa Artificial Intelligence )
4 Azure RTOS ThreadX Port (rm_threadx_port) Audio Z
v i System Thread Bootloader 7
& Azure RTOS GUIX Connectivity 2
& g_timer0 Timer, General PWM (r_gpt) Dsp ’
& Touch Thread Graphics >
| mput > 4+ Extenal IRQ (icy) |
Monitoring >
Motor >
Networking >
Objects % | New Object >
Power >
Security >
Sensor >
Storage >
System >
Summary BSP  Clocks  Pins Interrupts  Event Links | Stacks Components Timers ’
Figure 21. Add External IRQ
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3. Name the module “g_int_gt911” and change the default settings based on the properties illustrated in

the following image. Click “arrow” lﬁ to go to the Pins tab automatically for setting pin P510.

40 [mipi_ek_ra8d1_guix_hello_world] FSP Confi.. > | [&] startup.c L¢] main.c <] *system_thread_entry.c = B | Properties X 5= Outline

Stacks Configuration o g_int_gt911 External IRQ (r_icu)

Generate Project Content

Settings  Property Value

Threads % | New Thread % Remove |- g_int_gt911 External IRQ ¥ | New Stack > G ¥ Common
nfo

Y (r_icu) Stacks = Exend Stack > % | Remove Parameter Checking Default (BSP)
v % HAL/Common = v i
i ‘ Module g_int gt911 External IRQ (r_icu)
42 g_ioport I/0 Port {1 joport) YT Hifia g1
g Azure RIOS ThreadX Port (im_threadx_port) zi'"m—gl = s
|-v g_int_gt911 External IRQ (r_icu) | Trigger Rising
v & System Thread o Digital Filtering Disabled
a8
W P RO, Digital Filtering Sample Clock (Only valid when Dig PCLK / 64
4 g_timer_PWM Timer, General PWM (r_gpt) Callback touch int callback
& Touch Thread Pin Interrupt Priority Priority 12
v Pins

Figure 22. Setting External IRQ Properties

4. Change the configuration pin P510 for DISP_INT signal pin so the Operation Mode is Custom and the
Input/Output of IRQ3 is P510.

557 *[ra8d1_guix_hello_world] FSP Configuration X -y

o

Pin Conﬁguratlon Generate Project Content

Select Pin Configuration _y,} Export to CSV file E Configure Pin Driver Warnings

‘ RASD1 Eld V‘ Manage configurations...

Generate data: ‘ g_bsp_pin_cfg ‘

Pin Selection i~ [+ =/ /% Pin Configuration “J Cycle Pin Group
‘ Type filter text ‘ Name Value Lock
Pin Group Selection Mixed
¥ HMI:CEU ) .
Operation Mode Custom
+ HMI:GLCD
7 TRa ] v Input/Output
7 Interrupt: IRQ3 ¥ P510 &
IRQ
IRQO
IRQ1
IRQ2
| ~ rRQ3 |
IRQ4
IRQ5 < >
2eln Modul : IRQ3
IRQ7 . odule name:
< >

Pin Function | Pin Number

Summary | BSP | Clocks | Pins | Interrupts | Event Links | Stacks | Components

Figure 23. Configuration Pin P510 “IRQ3”
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5. Go back to the Stacks tab. From the Threads window, select HAL/Common and click “New Stack” and
add the Connectivity > 12C Master (r_iic_master) module.

¢ *[ra8d1_guix_hello_world] FSP Configuration <

Stacks Configuration

Threads % | New Thread % | Remove |—

v -’?‘ HAL/Common
¥ g_ioport I/O Port (r_ioport)

4 Azure RTOS ThreadX Port (rm_threadx_port)
& g_external_irq0 External IRQ (r_icu)
v & System Thread
& Azure RTOS GUIX
@ g_timerQ Timer, General PWM (r_gpt)
& Touch Thread

Objects ¢ | New Object >

o

= B || properties X

Touch Thread
Generate Project Content
Settings Property
Touch Thread Stacks |+ | New Stack > v Common
Analog > General
4 g_touch _irq External IRQ Artificial Intelligence > Timer
(r_icu) Audio > Trace
Bootloader > Performance
@ | connectivity > |4 Azure RTOS USBX DFU
DSP > @ Azure RTOS USBX HCDC
Graphics > @ Azure RTOS USBX HHID
Input > @ Azure RTOS USBX HPRN
Monitoring s 4 Azure RTOS USBX HUVC
Motor 5 4 Azure RTOS USBX OTG CDC
Networking , @ Azure RTOS USBX OTG HID
Power s @ Azure RTOS USBX PAUD
Security 3 @ Azure RTOS USBX PCDC
;R > 4 Azure RTOS USBX PHID
Storage 5 4 Azure RTOS USBX PMSC |
@ Azure RTOS USBX PPRN |
System >
4 CAN FD Lite (r_canfdlite)
Timers >
4 12C Communication Device (rm_comms_i2c)
Transfer >
4 12C Master (1_iic_b_master)
palocarch, [ 12¢ Master (iic_masten |
4 12C Master (r_sci_b_i2d)
4 12C Shared Bus (rm_comms_i2c) I

Summary | BSP | Clocks | Pins | Interrupts | Event Links | Stacks | Components

Figure 24. Add Touch 12C Master
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6. Name the module “g_i2c_gt911” and change the default settings based on the properties illustrated in

the following image. Click the “arrow” Iﬁ to go to the Pins tab automatically for setting pins SCL1 and
SDA1.

127 (mipi_ek ragd1_guix_hello_world] FSP Configuration X = O | [ Properties X | E% Outline

g_i2c_gt911 I2C Master (r_iic_master)

Stacks Configuration

Generate Project Content

Settings  ProPery Value
Threads & New Thiead % Remove = g j2c gt911 12C Master &) New Stack > Apllinfg | ¥ Common
v &% HAL/Common (r_iic_master) Stacks Parameter Checking Default (BSP)
0ot DIC on Transmission and Reception Disabled
& Z;UIE RTOS Thread;( Port (rm_threadx_port) 5 2 L b T i) = 109 siave addressing = Dizabled
Module g_i2c_gt911 12C Master r_iic_master)
4 g int gt911 External IRQ (r icu aine 312 gto11
4 g_i2c_gt911 12C Master (r_iic_master) @ Channel
v & System Thread 7 Rate Standard
4 Azure RTOS GUIX Rise Time (ns) 120
@ g_timer_PWM Timer, General PWM (r_gpt) % Add DIC Driver for %7 Add DTC Driver for Fall Time (ns) 120
& Touch Thread Transmission [Optional] Reception [Optional] Duty Cyde () o0
Slave Address
Address Mode 7-Bit
Timeout Mode Short Mode
Timeout during SCL Low Enabled
Gallback
Interrupt Priority Level Priority 8
v Pins
sci <unavailable>
= B

1¢ *[ra8d1_guix_hello_world] FSP Configuration

o

Pin Conﬁguratlon Generate Project Content

Select Pin Configuration _5} Export to CSV file E Configure Pin Driver Warnings

| RASD1 EK V| Manage configurations...
Generate data: | g_bsp_pin_cfg |
Pin Selection i= [+ =/ /% Pin Configuration =} Cydle Pin Group
| Type filter text ‘ Name Value Lock Link
= e " Pin Group Selection _Aonly
Emcetaly: Operation Mode Enabled
v ¥ Connectivity:lIC
o v Input/Output
T SCL1 ¥ P512 g [
SDA1 ¥ P511 i
¥ Connectivity:MIPI o |
¥ Connectivity:OSPI
¢ Connectivity:SCI
Connectivity:SDHI
¢ Connectivity:SPI
Connectivity:SSIE < >
¥ Connectivity:USB FS .
P Module name:  11C1
Connectivity:USB HS
¥ Debug:JTAG/SWD v Usage: For IIC, use same Pin Group for SDA/SCL signals =
) PRYTUPRpry Sy DO | NPl ¥ T [ W PO e presasey 1
Pin Function | Pin Number |
Summary | BSP | Clocks | Pins| Interrupts | Event Links| Stacks | Components
Figure 25. Name and Settings Properties
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7. Click New Object and add Semaphore. This semaphore will indicate when a gt911 touch interrupt
occurs.

W7 [mipi_ek_ra8d1_guix_hello_world] FSP Configuration < = 0

o

Stacks Conﬁguratlon Generate Project Content

Threads % | New Thread = HAL [Coim o Stacke &) New Stack > =% Extend Stack >
v -:} HAL/Common %] Remove

¥ g_ioport I/O Port (r_ioport)

4% Azure RTOS ThreadX Port (rm_threadx_port) ® e iden LT N2 Wit ik memasicn)

& g_external_irg0 External IRQ (r_icu)

% g_i2c_gt911 12C Master (r_iic_master) @

v & Systemn Thread =
4 Azure RTOS GUIX ' '
@ g_timer0 Timer, General PWM (r_gpt) % Add DTC Driver for % Add DTC Driver for
& Touch Thread Transmission [Optional] Reception [Optional]
Objects 4 | New Object >
@ Fvent Flags
@ Mutex
@ Queue
& Semaphore
|
Figure 26. Add New Semaphore
8. Name it g_semaphore_gt911_irq and set the following properties.
& *[mipi_ek ra8d1_guix_hello_world] FSP Configuration = B [ properties X |
Stacks Configuration o Pgm o g_semaphore_gt911_irq Semaphore
Settings  PIOPerty Value
Threads &) New Thread = 4] New Stack > Name Semaphore G911 IRQ
LBl s Symbol g_semaphore_gt911_irq

v m HAL/Common

Initial count 0
& g_ioport I/O Port (r_ioport) = =
4 Azure RTOS ThreadX Port (rm_threadx_port) . 3':252::)"’0 Port € ﬁ:'fhira%i;h;;dx Port
4 g_external_irq0 External IRQ (r_icu) = =
+ g_i2c_gt911 12C Master (r_iic_master) @ ®
~ @ System Thread

& Azure RTOS GUIX
@ g_timer0 Timer, General PWM (r_gpt)
& Touch Thread

Objects @ | New Object > % | Remove

I ® g_semaphore_gt911_irq Semapholeil

Figure 27. Add and Name Touch Semaphore

9. Click New Object and add another Semaphore. This semaphore will be used for i2¢ timing control.
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Stacks Configuration

Threads é_i New Thread

ﬁ, *[mipi_ek_ra8d1_guix_hello_world] FSP Configuration <

v -Ffé HAL/Common

& g_ioport I/O Port (r_ioport)

& g_external_irq0 External IRQ (r_icu)
P g_i2c_gt911 12C Master (r_iic_master)
v & System Thread
4% Azure RTOS GUIX
P g_timerQ Timer, General PWM (r_gpt)
& Touch Thread

HAL/Common Stacks

4-_1 New Stack >

= g
o

Generate Project Content

(=] x
47 Azure RTOS ThreadX Port (rm_threadx_port) & g po L CRaE

(r_ioport)

®

®

4% Azure RTOS ThreadX Port
(rm_threadx_port)

= E = T Event Flags
® g _semaphore gt911 irq Semaphore ® Mutex
& Queue

Objects & | New Object > # | Remnve

= Semaphore

Figure 28. Add Another New Semaphore
10. Name it “g_semaphore_gt911_i2c” and set the following properties.

4 *[mipi_ek_ra8d1_guix_hello_world] FSP Configuration

Stacks Configuration

Threads % | New Thread

=0

Generate Project Content

% | New Stack >

- HAL/Common Stacks
v = HAL/Common
4 g ioport I/0 Port (r_ioport) = P 7
& Azure RTOS ThreadX Port (rm_threadx_port) b gifopnrt i Cort lgie o denacTory
] . A (rioport) (rm_threadx_port)
¥ g_external_irq0 External IRQ (r_icu)
$ g_i2c_gt911 12C Master (r_iic_master) @ ®
v & System Thread
4 Azure RTOS GUIX

4 g_timer0 Timer, General PWM (r_gpt)
& Touch Thread

Objects € | New Object > ® | Remove

® g_semaphore_gt911_irq Semaphore
I. g_semaphore_gt911_i2c Semaphore I

[T properties X

g_new_semaphore0 Semaphore

Settings Property
Name
Symbol
Initial count

Value

Semaphore GT911 12C
g_semaphore_gt911_i2¢c
0

Figure 29.

Add and Name 12C Semaphore
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11. Click New Object and add Event Flags. This event flag will be used by the gt911 drivers.

if‘;f *Imipi_ek_ra8d1_guix_hello_world] FSP Configuration < = O

o

Stacks Co nﬁguratlo 4 Generate Project Content

Threads % | New Thread .| & = % | New Stack >
HAL/Common Stacks

v i?‘& HAL/Common

¥ g_ioport I/Q Port (r_ioport)

4% Azure RTOS ThreadX Port (rm_threadx_port)

£ g_external_irq0 External IRQ (r_icu)

$ g_i2c_gt911 12C Master (r_iic_master) @ @
v & System Thread

4 Azure RTOS GUIX

$ g_timer0 Timer, General PWM (r_gpt)

& Touch Thread

4 g_ioport /O Port 4 Azure RTOS ThreadX Port
(r_ioport) (rm_threadx_port)

Objects & | New Object >[ % | Remove
@ g_semaphore_gt911_irq Semaphore ' E¥ett Hads
@ g_semaphore_gt911_i2c Semaphore o uic
® Queue

® Semaphore
I

Figure 30. Add Event Flags

12. Name it “g_event_flags_gt911” and set the following properties as shown.

95¢ [mipi_ek_ra8d1_guix_hello_world] FSP Configuration * =0|s Properties <
Stacks Configuration 0 g_new_event_flags0 Event Flags
Generate Project Content
Settings Property Value
Threads % | New Thread H % | New Stack > Name GT911 Event Flags
HAL/Common Stacks
= Symbol g_event_flags_gt911
v &' HAL/Common
& g_ioport 1/O Port (r_ioport) ,u P
47 Azure RTOS ThreadX Port (rm_threadx_port) | ” g_fopod valort faure RIOE ThremcOiort
. ¥ 2 | (r_ioport) (rm_threadx_port)
4 g_external_irq0 External IRQ (r_icu)
@ g_i2c_gt911 12C Master (r_iic_master
E gi2cg (r_iic_ ) ® ®
v @ System Thread

4% Azure RTOS GUIX
& g_timerQ Timer, General PWM (r_gpt)
& Touch Thread

Objects % | New Object > ® | Remove

® g_semaphore_gt911_irq Semaphore
® g_semaphore_gt911_i2c Semaphore

I. g_event flags_gt911 Event Flags I

Figure 31. Name Event Flags and Setting Properties
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FPC CONNECTOR FOR CAPACITIVE TOUCH

3.3V 3.3V

a3v FH12-85-0 5SH

CN3
1 1
206< 2B5< PAD1 DISP_RST 2 2
2B1> 1 P510 DISP_INT 3 3
2B5<> y  Poli . IIC_SDA 4 S
IB5< P512 IIC_SCI i 5
i = -
nc / T
828

9 FG[1]

: 10 FGI2]

Figure 32. Touch Pins Connected on the MIPI LCD

The pins marked in Figure 32 are used for the touch panel controller on the MIPI LCD board:

o DISP_INT interrupt (P510) is used to trigger touch events.

e 12C channel 1 (P512, P511) is used to read and write data to the touch controller.

e Touch driver folder touch gt911 for touch function is inside the provided Source folder.
e PAO1 is used to reset the MIPI LCD’s touch controller.

13. Refer to the touch thread entry.c filein Source.zip for more information. The following
code initializes the touch controller and process touch events.
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/* New Thread entry function *
void touch_thread_entry(void)

{
GX_EVENT gxe = {6};
gxe.gx_event_type GX_EVENT_PEN_UP;
uint8_t status = 6;

. )0: add your own code here */
touch_gt911_ctrl_t gt9ll_ctrl;
fsp_err_t err = FSP_SUCCESS;
uint32_t gt9ll_err = 0;
uintlé_t gt9ll_fw_version = @;

UINT tx_err = TX_SUCCESS;

#1f USE_EVENT_FLAGS == 1
ULONG actual_flags =
#endif

8;

err = R_TOUCH_GT911_Validate(8gt911_cfg, &gt9ll_err);
if(FSP_SUCCESS 1= err)

__BKPT(@);

memset (8gt911_ctrl, @, sizeof(touch_gt911_ctrl_t));
err = R_TOUCH_GT911_Open(&gt911_ctrl, &gt91l_cfg);
- if (FSP_SUCCESS = err)

__BKPT(@);

err = R_TOUCH_GT911_Reset(&gt911_ctrl);
= if(FSP_SUCCESS != err)
__BKPT(@);

S#if 1
err = R_TOUCH_GT911 VersionGet(&gt911 _ctrl, &gt911 fu_version);

S if(FSP_SUCCESS != err)
__BKPT(®);
i
#endif
e while (FSP_SUCCESS == err)
{

- #if USE_EVENT_FLAGS
tx_err = tx_event_flags_get(&g_event_flags_gt91l1,
TOUCH_GT911_INT,
TX_OR_CLEAR,
&actual_flags,
TX_WAIT_FOREVER);
= #elif USE_SEMAPHORES == 1
tx_err = tx_semaphore_get(&g_semaphore_gt911_irq, TX_WAIT_FOREVER);
#endif

e if(TX_SUCCESS != tx_err)
{

err = FSP_ERR_INVALID_STATE;
__BKPT(8);

}
- #1f USE_EVENT_FLAGS == 1
if((actual_flags & TOUCH_GT911_INT) != TOUCH_GT911_INT)

continue;

#endif
err = R_TOUCH_GT911_StatusGet(&gt9ll_ctrl, &status, true);

S if(status & GT911_BUFFER_READY)
{

gt911_touch_coords.touch_count = status & GT911_MASK_TOUCH_COUNT;
err = R_TOUCH_GTS11_PointsGet(&gt911_ctrl, &gt911_touch_coords);

- if(eu < gt911_touch_coords.touch_count && GX_EVENT_PEN_UP == gxe.gx_event_type)
/* Send only the TOUCH event of the first finger to the GUIX Model View Controller. */
translate_touch_coordinates(8gt911_touch_coords.point[@], ORIENTATION_ROTATE_CW);
gxe.gx_event_payload.gx_event_pointdata.gx_point_x = gt911_touch_coords.point[0].x;
gxe.gx_event_payload.gx_event_pointdata.gx_point_y = gt911_touch_coords.point[@].y;
gxe.gx_event_type = GX_EVENT_PEN_DOWN;

gx_system_event_send(&gxe);

}

- if ( eU == gt91l_touch_coords.touch_count && GX_EVENT_PEN_DOWN == gxe.gx_event_type)
d gxe.gx_event_type = GX_EVENT_PEN_UP;
gx_system_event_send(&gxe);
tx_thread_sleep (1);
- if(FSP_SUCCESS = err)

__BKPT(@);

err = R_TOUCH_GT911_Close(&gt911_ctrl);

Figure 33. Initializes the Touch Controller and Process Touch Events
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14. From Stacks Configuration, click “Generate Project Content” to generate project content.

{0¢ [mipi_ek_ra8d1_guix_hello_world] FSP Configuration > =0

Stacks Configuration o

Generate Project Content

Threads % | New Thread # | Remove |— g i2c gt911 12C Master % | New Stack >
(r_iic_master) Stacks

Wi .;* HAL/Common
& g_ioport I/O Port (r_ioport)
47 Azure RTOS ThreadX Port {(rm_threadx_port)
& g_external_irq0 External IRQ (r_icu)
3 g_i2c_gt911 12C Master (r_iic_master) @
v {&# System Thread
4% Azure RTOS GUIX ' '

@ g timer0 Timer, General PWM (r gpt) % Add DTC Driver for % Add DTC Driver for
O ik Thicesi Transmission [Optional] Reception [Optional]

P g_i2c_gt911 12C Master (r_iic_master)

Objects % | New Object > # | Remove

® g_semaphore_gt911_irg Semaphore
® g semaphore _gt911_i2c Semaphore
@ g_event flags_gt911 Event Flags

Summary | BSP | Clocks | Pins | Interrupts | Event Links | Stacks | Components

Figure 34. Generate Project Content

15. Unzip and open the provided folder Source. zip. Copy 6 files and 2 folders SEGGER RTT,
touch gt911 and paste into the folder src of your project “mipi_ek_ra8d1_guix_hello_world”.
Select “Yes” if you are prompted to overwrite existing files.

SEGGER_RTT folder

e touch gt9ll folder

e common utils.h

e hal entry.c

e system thread entry.c
e system thread entry.h
e touch thread entry.c
e windows handler.c
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a EK_RA8D1 - mipi_ek_ra8d1_guix_hello_world/configuration.xml - e? studio
File Edit Source Refactor Navigate Search Project Renesas Views Run Renesas Al Window Help

B "t Qv
{3 Project Explorer X =k
vis mipi_ek ra8d1 guix hello world [Debug]
> ) Indludes

B ra

> B ra_gen

v (B stc

(&> SEGGER RTT

= touch_gt911

thl common_utils.h

L€ hal_entry.c

L€ system_thread_entry.c

[W system_thread_entry.h
» €] touch_thread_entry.c

» 1g windows_handler.c

(= Debug
> k= racfg
= saipt
,’;‘r configuration.xml
X| mipi_ek_ra8d1_guix_hello_world Debug_Flat.launch
= ra_cfg.xt
» (2) Developer Assistance

L & = O {8 [mipi_ek _ra8d1_guix_hello_world] FSP Configuration X

Stacks Configuration

Threads % | New Thread ®|Remove —

v #¢ HAL/Common
& g_ioport |/O Port (r_ioport)
4 Azure RTOS ThreadX Port (rm_threadx_port)
& g_external_irq0 External IRQ (r_icu)
% g_i2c_gt911 12C Master (r_iic_master)

v i System Thread
4 Azure RTOS GUIX
@ g_timer0 Timer, General PWM (r_gpt)

i Touch Thread

Objects % | New Object > ® | Remove

@ g_semaphore_gt911_irg Semaphore

® g_semaphore_gt911_i2c Semaphore
® g_event flags_gt911 Event Flags

g i2c_gt911 12C Master
(r_iic_master) Stacks

= fg]
o

Generate Project Content

% | New Stack >

= L

@

@ g.i2c_gt911 12C Master (r_iic_master)

% Add DTC Driver for
Transmission [Optional]

%~ Add DTC Driver for
Reception [Optional]

Summary | BSP | Clocks Pins | Interrupts | Event Links Stacks Components

Figure 35. Copy All Folders and Files from Source.zip to the e? studio Project’s src Folder
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4. Create Folders in the “mpi_ek_ra8d1_guix_hello_world” Project for Azure RTOS
GUIX Studio Project

1. Under folder src, right click to create a new folder and name it guix_gen following the image below,
then click Finish. This folder will store the files that a GUIX Studio graphics application generates.

{5 Project Explorer X -5 § T 8 | 4F mipiek_ra8d1_guix_hello_world] FSP Configuration <
v =5 mipi_ek _ra8d1_guix_hell Id [Deb 5
== mipi_ek_ra8d1_guix_hello world [Debug] Stacks Conﬁguratlon
Y Includes
Threads % | New Thread # | Remove [—
[ 811 icnmmnan
= New > j‘ Project...
= Go Into lc7] C/C++ Project 1_threadx_port)
Lhi Open in New Window " File r_icu)
Ll Show In Alt+Shiftsw > [ File from Template master)
. =] Copy Ctrl+C I'—T iy
| o
— Paste Ctrl+v & Class
li' K Delete Delete  |h Header File A (r_apY
< Soriizs s € Source File
(& De Move... 2% Source Folder
(= ra) .
Rename... F2 [ Example..
& sc R
6t o Import... ™1 Other... cul+N > H&lRemove
1w
X m 3 Export.. g_semaphore_gt911_irq Semaphore
R Build Project Ctrl+p | 9_semaphore_gt311_i2c Semaphore
@ D¢ Tafrelh F5 | g event flags gt911 Event Flags
Index >
Build Targets >
Figure 36. Create a New Folder Named “guix_gen”
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2. Create a new folder at the topmost project level and name it guix studio by following the image
below. Click Finish. This folder will store the GUIX Studio project.

Ly Project Explorer X =hs § = O |{e [mipi_ek_ra8d1_guix_hello_world] FSP Configuration X< =
\-Il.-:c,- mipi_ek ra8d1_guix hello world [Dehug4 0
i)Y Includes New 24 I [ Project... erate Project Content
@B ra Go Into [ C/C++ Project
£ ra_gen Open in New Window File >
v (@ sic Show In Alt+Shift+W > File from Template
(= guix_gen Copy CtrlsC I_’ Folder
(= SEGGER_RTT Paste Ctrl+V 6 Class Create a new folder resource
(& touch_gt911 ® Delete Delete |h Header File
{h common_utils.h Solie , [ Source File
£ hal_entry.c Moves 9 Source Folder
,_c' system thread entry.c Rename... F2 [ Converttoa C/C++ Project (Adds C/C++ Nature) . _
n| system_thread_entry.h IC Driver for
L€] touch_thread_entry.c | LR [ Example... on [Optional]
¢] windows_handler.c K Export.. [ Other... Ctrl+N
@ Debug Renesas FSP Export > I | | | |
& racfg Blicibokd % Remove : e
= script Clean Project
45 configuration.xml Refresh F5
X mipi_ek ra8d1_guix_hello world Debug_ Close Project
- ra_cfg.tet Close Unrelated Project
Q) Developer Assistance Buid et .
Index 2l
e New Folder [ X
Folder

Create a new folder resource.

Enter or select the parent folder:

mipi_ek_ra8d1_guix_hello_world

=

=5 mipi_ek_ra8d1_guix_hello_world [Debug]

Folder gameﬂ qguix_studio|

Advanced >>

Cancel

Figure 37. Create New Folder and Name “guix_studio”
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3. Under folder guix_studio, create a new folder and name GNU. Follow the image below, then click
Finish.

{5 Project Explorer < =5 7 & = O ||k [mipi_ek ra8d1_guix_hello_world] FSP Configuration ><

v i mipi_ek_ra8d1_guix_hello_world [Debug] Stacks Configuration

[n Includes
Bra s
@ ra_gen Threads % | New Thread # | Remove |-
v (2 src v .f:} HAL/Common
[~ guix_gen 4 g_ioport /O Port (r_ioport)
= SEGGER_RTT @ Azure RTOS ThreadX Port (rm_threadx_port)
(= touch_gt911 4 g_external irq0 External IRQ (r_icu)
[l common_utils.h P g_i2c_gt911 12C Master (r_iic_master)
l£| hal_entry.c v 4 System Thread
€] system_jasaaskmand O
R D New b I; ., Project... .
B toich oy Go Into e’ C/C++ Project
[£] windows Show In Alt+Shift+w > || File
&= Debug B Copy Cul+C I File from Template
[ g o] o
= QU'Xf_S udio Paste Ctrl+V TIENE
= ra_cfg & o p—
. ) K Delete Dkt e |Create a new folder resource
- script Move... ™ Example..
54 configuratic
et Rename... 2 4 Other.. Ctrl+N
|X] mipi_ek ra8
= Import..
-| ra_cfg.txt
i3 Export..
@ Developer £
Build Project Ctrl+B
Q New Folder O X

Folder

.
Create a new folder resource. f j

Enter or select the parent folder:

mipi_ek_ra8d1_guix_hello_world/guix_studio ‘

v =5 mipi_ek_ra8d1_guix_hello_world [Debug]
= .settings
= Debug
= guix_studio
>ra
= ra cfg
=+ ra_gen
= script
&= src

Folder name:l GNU I

Advanced >>

‘?' Cancel
Figure 38. Create New Folder and Name “GNU”
R12AN0134EU0100 Rev.1.00 Page 30 of 63

Feb.09.24 RENESAS




Renesas RA Family GUIX Hello World for EK-RA8D1 MIPI LCD Display

4. After the sub-folder GNU is created, the folder structure should look like the image below.

Q EK_RA8D1 - mipi_ek_ra8d1_guix_hello_world/configuration.xml - ? studio

File Edit Source Refactor Navigate Search Project Renesas Views Run Renesas Al Window Help

%3'%' e Ttl_}'qu

5 Project Explorer X -5, = 0 ||{58 [mipi_ek_ra8d1_guix_hello_world] FSP Configuration <
v ".'5 mipi_ek_ra8d1_guix_he||o_wor|d§ q
B : Stacks Configuration
33 Binaries
it Includes _
89 2 Threads % | New Thread —
= ra_gen v -"E:’ HAL/Common
v 8 sic 4 g_ioport I/O Port (r_ioport)
= guixigen 4 Azure RTOS ThreadX Port (rm_threadx_port)

f= touch_gt911 4 g_int_gt911 External IRQ (r_icu)

$ g_i2c_gt911 12C Master (r_iic_master)
L€ v & System Thread
1E| system_thread_entry.c 4 Azure RTOS GUIX
[n system_thread_entry.h

lb] common_utils.h

€] hal_entry.c

P g_timer PWM Timer, General PWM (r_gpt)

€] touch_thread_entry.c & Touch Thread
L] windows_handler.c
(= Debug
v [ guix_studio Objects & New Obiject >
= GNU ® g semaphore_gt911_irq Semaphore
& ra_f:fg @ g_semaphore_gt911_i2c Semaphore
= script

® g _event _flags_gt911 Event Flags

520 configuration.xml

Figure 39. After Created All the Folders and it looks like above
5. Using Azure RTOS GUIX Studio create GUI Windows
1. Open Azure RTOS GUIX Studio v6.3.0.1 or greater.

T

GUIX Studio

Figure 40. GUIX Studio Icon
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2. The following sub-steps will walk you through creating a new project named Hello World.
A. Select Project. From the drop-down list, select New Project.
B. Project Name: Hello_World.
C. Project Path: Browse to the location of the folder you created in e? studio, the
mipi_ek_ra8d1_guix_hello_world\ guix_studio\GNU as shown in the image below.
D. Click the OK button and then the Save button to confirm your selections.

JGI Azure RTOS GUIX Studio 6.2.1.0 - Hello_World

Project Edit Insert Configure Help

New Project CheN | W = G55 Q@ M F O
Open Project Cul+0 :

i Create New Project
Save Project Ctrl+S
Save Project As Shift+Ctrl+S

. *

Close Project Project Name | Hello_World |
Ipen e Project Path *|C:\WorkSpace\iaEdl,guix,hellu,world\guix,sludia\GNU | T s

Recent Projects > * Indicates required field

Generate All Output Files

Generate Resource Files Cancel Save

Generate Specification Files

Q EK_RA8D1 - mipi_ek ra8d1_guix_hello_world/configurationxml - ? studio

Exit Alt+F4
File Edit Source Refactor Navigate Search Project RenesasViews Run Renesas Al Window Help

ERE S o e Q-
{5 Project Explorer X -5 7 8 = O &F [mipi_ek_ra8d1_guix_hello_world] FSP Configuration X

+ =5 mipi_ek_ra8d1_guix_hello_world [Debug] Stacks Configuration

[n! Includes
LEL ra
@ ra_gen Threads % | New Thread # | Remove |-
2 src v ;,* HAL/Common
(= Debug 4 g_ioport /0 Port (rioport)
W (= guix_studio 4% Azure RTOS ThreadX Port (rm_threadx_port)
= GNU 4 g_external_irq0 External IRQ (r_icu)
(= ra_cfg % g_i2c_gt911 12C Master (r_iic_master)
& seript W & System Thread
2 configuration.xml 4% Azure RTOS GUIX
X mipi_ek_ra8d1_guix_hello_world Debug_Flat.launch 4 g_timer0 Timer, General PWM (r_gpt)
ra_cfg.txt & Touch Thread

Figure 41. GUIX Studio Creates Hello World Project
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3. A new Configure Project window will pop up and you need to set all the options as shown in Figure 42.
Take care to also set the Advanced Settings. Finally, when your project settings match those reflected in

the following image, click Save.

{} Configure Project % N {1 Renesas Graphics Advanced Settii ®

Directories

Source Files I| .-\.-\src\guix_gen

browse...

Header Files I| .-\.-\src\guix_gen

browse...

Resource Files I| -\-\src\guix_gen

browse...

Target CPU | Renesas RA

b Advanced Settings

Toolchain [ GNU ~ [ ]big endian

Additional Headers |

| [Jinsert Before

Number of Displays |[1 |2 GUIX Library Version | 6 - .[2 2 .[1 3

Major Minor  Patch

Enable 2D Drawing Engine

Runtime Image Decoder
JPEG:  Software JPEG Decoder

PNG: ‘Software PNG Decoder

~

~

Cancel

Display Configuration
Display Number} IZ = Name | display |
x resolution pixels y resolution pixels
()1 bpp grayscale 1:5:5:5 format
2 bpp invert polarity 4:4:4:4 format
(O4bpp
()8 bpp reverse byte order 3:3:2 format
()16 bpp packed format
24 b .
IDaIIocate canvas memory I Rotation:
()32 bpp
8
Cancel

Save

Figure 42. Configuration New Project “Hello World” with Advanced Settings
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4. The default view of the New Project “Hello World” will look like the following image:

|Gl Azure RTOS GUIX Studio 6.3.0.1 - Hello_World

Project Edit Insert Configure Help
B & B X &8 R 47 LIbakLLEDIQg&@ M F @

h Project View 5 | & Theme: "theme_1"

[ Hello_wWorld
L display_1
== default_folder

vindow} [& Pixelmaps

«» Strings

[T Properties View -

Widget Type: window ~
Widget Name window

Widget Id

User Data.

Left 0
Top 0

Width 854

Height 480

Border Thin Border =
Transparent L]
Draw Selected |
Enabled [v]
Accepts Focus
Runtime Allocate B
Normal fil WINDOW_FILL >
Selected fil WINDOW_FILL v
Disabled fill DISABLED_FILL b
Templale H|
\isible At Startup ]
Draw Function

Event Function

Wallpaper Hone ~
Tile Wallpaper (|

Figure 43. After Settings New Project “Hello World”
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5. Select Window1 in the Project View, and in the Properties View make sure the settings for Window1
match the following image.

JG{ Azure RTOS GUIX Studio 6.3.0.1 - Hello_World.gxp
Project Edit Insert Configure Help

- B b9 83 B =
[£ Hello_World

L display
=-La default_folder
- Window1

(Widget Type window
(Widget Name Window1
(Widget Id ID_WINDOW1
User Data
Left 0
Top 0
(Width 854
Height 480
Border No Border bied
Transparent [l
Draw Selected ]
Enabled
Accepts Focus
Runtime Allocate []
Normal fill WINDOW_FILL &
Selected fill WINDOW_FILL o
Disabled fill WINDOW_FILL e
Template ]
Visible At Startup ]
Draw Function
Event Function window1_screen_event |
\Wallpaper None -
Tile Wallpaper O

Figure 44. Properties View of Window1

6. Toadd String ID, click on Strings. Follow the images below.

B oo 5 Q@& mMpr F 6
=1l Theme: "theme_1"

& Colors

T Fonts

[l Pixelmaps

<[> Strings =

Figure 45. Strings
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7. From the Strings dropdown, click + Add New String.

il o & O @ & md » F @
£l Theme: "theme_1"

& Colors

[&] Pixelmaps

«J» Strings
String ID English 4k

T+1 Add New String

Figure 46. Add New String
8. New String Table Editor window will pop up. Click the Add String button.

<l> Strina Table Editor

Add String Delete String Import Export [a Sorting By: | String ID v

Stringld - English ~ 4| Widgets that use this stning:

STRING_1

* Indicates required field

String ID: *STRING_1 Number of references- 0

String Text: Stning width (pixels): 0
Font: SYSTEM v
Notes:

Cancel Save

Figure 47. String Table Editor
9. Edit String ID and String Text.

R12AN0134EU0100 Rev.1.00 Page 36 of 63
Feb.09.24 RENESAS




Renesas RA Family GUIX Hello World for EK-RA8D1 MIPI LCD Display

</> String Table Editor

Add String Delete String Import Export B Sorting By: | String ID >

Stringld v English ~ 4| Widgets that use this string:

CHECKBOX_TEXT Press Me!

* Indicates required field

—
Sting ID: 4|CHECKBOX _TEXT | Number of references:
String Text: Pr ess M e ] String width (pixels):

Font: SYSTEM

Notes:

Cancel

Save

Figure 48. Edit String ID and String Text

10. Continue to click Add String, and edit each new entry’s corresponding String ID and String Text until

the table appears like Figure 49. Then click the Save button.

«/» String Table Editor

Add String { Delete String Import Export l:lﬂ Sorting By: |None &

Stringld w English w 4| Widgets that use this string:
CHECKBOX_TEXT Press Mel Window1.buttonenabler
INSTRUCT_CHECKBOX Press to activate (blue), "Press me" for more.
|BUTTON_DISABLED Stay in window 1 Press Mel
(wiNnDOW1 Window1
[HELLO_WORLD Hello World -> Press anywhere to go to window 1
[wiNDOW2 Window2
[BUTTON_ENABLED GoTo Window 2
INSTRUCT_BUTTON Press "Goto window2" to show the next screen.
+ Indicates required field
String ID: * ‘CHECKBOX_TEXT Number of references: 1
String Text: Press Mel String width (pixels): 10

Font: SYSTEM

Notes:

Cancel

Save

Figure 49. All Strings
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11. Right-click on Window1 in the Project View to insert a Text Button and follow Figure 50.

]

]

lG[ Azure RTOS GUIX Studio 6.3.0.1 - Hello_World.gxp
Project Edit Insert Configure Help
_ I~ B * By & =N =l T Ig
[ Hello_World
=1L display
—-a default_folder
B inciow 1
Cut
Copy
Paste
: Delete
I Insert > I Folder
Widget Type werrroTry
Widget Name Window1 R 4
Widget Id ID_WINDC‘.I Button 4 Bution
User Data Text > Text Button
Left 0 Indicator > Multi Line Text Button
Top 0 Menu > Checkbox
Width 854 Radio Button
Height 480 Icon Button
Border No Border ~ Pixelmap Button
Transparent L Icon
Draw Selected ]
Enabled
Accepts Focus
Runtime Allocate ]
Normal fill WINDOW_FILL il
Selected fill WINDOW_FILL R
Disabled fill WINDOW_FILL S
Template ]
Visible At Startup ]
Draw Function
Event Function window1_screen_event
Wallpaper None ~
Tile Wallpaper L]

Figure 50. Insert Text Button
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12. Set Properties View of “text_button”.

JG| Azure RTOS GUIX Studio 6.3.0.1 - Hello_World.gxp

Project Edit Insert Configure Help
B & B ¥ B B k& & T L T om

o, Project View -

[& Hello_World
=L display
= default folder
=& Window1
£
Widget Type text_button
Widget Name windowchanger
Widget Id ID_WINDOWCHANGER
User Data
Left 109
Top 87
Width 243
Height 68
Border No Border i
Transparent |:|
Draw Selected ]
Enabled
Accepts Focus
Runtime Allocate |:|
Normal fill BTN_LOWER 2
Selected fill BTN_UPPER 2
Disabled fill BTN_LOWER ~
Draw Function
Event Function
Pushed ]
Toggle D
Radio L]
Auto Repeat
String ID None d
Text
Font PROMPT B2
Text Align Center 22
Normal Text Color BTN_TEXT bl
Selected Text Color BTN_TEXT b
Disabled Text Color BTN_TEXT i
Private Text Copy D

Figure 51. Properties View of text_button

13. Right-click windowchanger to insert a Prompt and follow Figure 52.
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tGI Azure RTOS GUIX Studio 6.3.0.1 - Hello_World.gxp

Project Edit Insert Configure Help
‘A m B X B P B Jd F L 2 w2 Q&S0 Q@ i+ F O

, Project View -

Hello World

Cut
Widget Type text b Paste
Widget Name windc Delete
Widget Id D_W
User Data —
Window >
Left 109
Top 87 Lo
Width 243
Height 68 Indicator b MNumeric Prompt
Borde Hio Border Menu > Pixelmap Prompt
Transparent ] e Numeric Pixelmap Prompt
Draw Selected ] _________ Single Line Input
Enabled Multi Line View
Accepts Focus Multi Line Input
Runtime Allocate [] Rich Text View
Figure 52. Insert Prompt
14. Set Properties View of prompt.
R12AN0134EUO0100 Rev.1.00 Page 40 of 63

Feb.09.24 RENESAS




Renesas RA Family

GUIX Hello World for EK-RA8D1 MIPI LCD Display

JG| Azure RTOS GUIX Studio 6.3.0.1 - Hello World.gxp

Project Edit Insert Configure Help
- B ¥ & D =

1 Project View
D Hello World

EH Properties View B

Widget Type prompt

Widget Name windowchangertext

Widget Id ID_WINDOWCHANGER_TEXT

User Data

Left 116

Top 95

Width 228

Height 52

Border No Border M
Transparent
Draw Selected []
Enabled
Accepts Focus []
Runtime Allocate D
Normal fill WIDGET_FILL ™
Selected fill SELECTED_FILL id
Disabled fill DISABLED_FILL M
Draw Function

Event Function

String ID BUTTON_DISABLED b
Text Stay in window1

Font PROMPT i
Text Align Center A
Normal Text Color TEXT B
Selected Text Calor SELECTED_TEXT b
Disabled Text Color DISABLED _TEXT b
Private Text Copy ) D

Figure 53. Properties View of Prompt

R12ANO134EU0100 Rev.1.00

Feb.09.24

Re Page 41 of 63
RENESAS




Renesas RA Family GUIX Hello World for EK-RA8D1 MIPI LCD Display

15. Insert new Button. Right-click on windowchangertext and follow Figure 52.

iG‘ Azure RTOS GUIX Studio 6.3.0.1 - Hello_World.gxp

Project Edit Insert Configure Help

O wm A X B 9 B S F L S W= B O G

Q @ m »

x 0

1, Project View
Hello World
- display
- default_folder
Bﬁ Window1

B windowchangertex

Cut
Ef Properties View

Button

Widget Type prompt Capy

Widget Name windowchang e

Widget Id ID_WINDOW Delete

User Data I Insert > I Folder
Left 116 Window
Top 95 Button
Width 228 Tt
Eell - Indicator
Border No Barder M
Transparent

Draw Selected []

Enabled

Accepts Focus []

Runtime Allocate [

Text Button

Multi Line Text Button

Checkbox
Radio Button
Icon Button
Pixelmap Button

lcon

Figure 54. Insert Button
16. Set the Properties view of the button.
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}G| Azure RTOS GUIX Studio 6.3.0.1 - Hello World.gxp

Project Edit Insert Configure Help

O & B ¥ 8 B 4 7F b 2 v 2

= L display A
= default_folder
= Window1
=@ windowchanger
= [=] windowchangertext

2 window1changer >
Widget Type button
Widget Name window1changer
Widget Id ID_WINDOW_1_CHANGER
User Data
Left 94
Top 85
Width 204
Height 50
Border No Border ™
Transparent
Draw Selected []
Enabled
Accepts Focus []
Runtime Allocate []
MNormal fill BTN_LOWER v
Selected fill BTN_UPPER v
Disabled fill DISABLED_FILL &
Draw Function
Event Function
Pushed []
Toggle []
Radio []
Auto Repeat []

Figure 55. Properties view of the Button
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17. Insert Prompt. Right click on Window1 and follow Figure 56. Insert two times to get two prompts.
Prompt and Prompt1 will show up once you finish.

}Gl Azure RTOS GUIX Studio 6.3.0.1 - Hello World.gxp

Project Edit Insert Configure Help

: L 2] ¥ By el = E v I Z ¥
1 Project View -

[ Hello_World

=L display

=3 default_folder

<

[-@ wind Cut
=-Elw  Copy

| Paste
Delete

Folder
FH Properties View Window
Widget Type window Button
Widget Name Window!  J_Text 2 Prompt
Widget Id ID_WINDOWA1 Indicator > Numeric Prompt
User Data Menu > Pixelmap Prompt
Left 0 Numeric Pixelmap Prompt
Top 0 Single Line Input
Width 854 Multi Line View
Height 480 Multi Line Input
Border No Border i Rich Text View
,,,,,,,,,,, i

JGI Azure RTOS GUIX Studio 6.3.0.1 - Hello_World.gxp

Project Edit Insert Configure Help
s — B 3 =E | =8

rh Project View -

[ Hello World
- L display
= default folder
5 £ Window1
=] prompt
k2] windowchanger

-] windowchangertext
“J window1changer

EE Properties View -

Figure 57. Insert Prompts
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18. Set the Properties View of Prompt.

JG| Azure RTOS GUIX Studio 6.3.0.1 - Hello_World.gxp

Project Edit Insert Configure Help

; - N TN N N—
rh Project View _
[ Hello_ World

EH Properties View -

Widget Type prompt

Widget Name instructions

Widget Id ID_INSTRUCTIONS

User Data

Left 103

Top 213

Width 649

Height 146

Border No Border ke
Transparent I:
Draw Selected []
Enabled [V
Accepts Focus [V
Runtime Allocate [
Normal fill WIDGET_FILL b
Selected fill SELECTERTEINE b
Disabled fill WIDGET_FILL ¥
Draw Function

Event Function

String ID INSTRUCT_CHECKBOX b
Text Press to activate (blue), "Press me" for
Font PROMPT v
Text Align Center %
Normal Text Color = e
Selected Text Calor SELECTED_TEXT b
Disabled Text Color TEXT o
Private Text Copy D

Figure 58. Properties View of Prompt
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19. Set the Properties View of Prompt1.

JG| Azure RTOS GUIX Studio 6.3.0.1 - Hello_World.gxp
Project Edit Insert Configure Help
: — 7] b4 Bl F =
[ Hello World
=E display
B default_folder
= Window1

] instructions

1= window1_text

i windowchanger

2= windowchangertext
- window1 changer

Widget Type prompt
Widget Name window1_text
Widget Id ID_WINDOW1_TEXT
User Data
Left 345
Top 390
Width 153
Height 68
Border No Border e
Transparent v
Draw Selected []
Enabled []
Accepts Focus [v]
Runtime Allocate |:
Normal fill WIDGET_FILL b
Selected fill SELECTED_FILL M
Disabled fill WIDGET_FILL ¥
Draw Function
Event Function
String ID WINDOWH1 Bz
Text Window1
Font PROMPT ¥
Text Align Center %
Normal Text Color TEXT s
Selected Text Colar SELECTED_TEXT b
Disabled Text Color TEXT v
Private Text Copy D

Figure 59. Properties View for Prompt1
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20. Click Insert > Button > Checkbox. Right click on Window1 and follow Figure 59.

JG| Azure RTOS GUIX Studio 6.3.0.1 - Hello_World.gxp

Project Edit Insert Configure Help

d I~ B b4 B3 e & = ™ In -]
th Project View -

[ Hello_World

21 display

&2 default_folder

Widget Type Button

Widget Name Window1 Text > Text Button

Widget Id ID_WINDOW Indicator > Multi Line Text Button
User Data Menu > I Checkbox

Left 0 Radio Button

Top 0 lcon Button

Width 854 Pixelmap Button
Height 480 [con

Figure 60. Insert Button Checkbox
21. Setting Properties View of Button Checkbox.
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JG{ Azure RTOS GUIX Studio 6.3.0.1 - Hello_World.gxp
Project Edit Insert Configure Help
, = @ X & B E
[& Hello_World ~
=~ display
=3 default_folder
= Window?
L
[z.] instructions

[ window1_text v
Widget Type checkbox ~
Widget Name buttonenabler
Widget Id ID_BUTTONENABLER
User Data
Left 576
Top 84
Width 174
Height 74
Border No Border Bt
Transparent
Draw Selected ]
Enabled [~]
Accepts Focus
Runtime Allocate D
Normalfill BTN_LOWER R
Selected fill BTN_UPPER £
Disabled fil BTN_LOWER b
Draw Function
Event Function
Pushed D
Toggle
Radio ]
Auto Repeat []
String ID CHECKBOX_TEXT b
Text Press Me!
Font BUTTCN =
Text Align Left e
Normal Text Color BTN_TEXT e
Selected Text Color BTN_TEXT i
Disabled Text Color BTN_TEXT 4
Private Text Copy I:‘
Unchecked Pixelmap CHECKBOX_OFF b
Checked Pixelmap CHECKBOX_ON ~
gnchecked Disabled None £

Figure 61. Setting Button Checkbox Properties
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22. After you finished creating Window1, it should be like the image below.

DG' Azure RTOS GUIX Studio 6.3.0.1 - Hello_World.gxp

Project Edit Insert Configure Help
L] ] ¥ By vl

th Project View

(& Hello_World
=-Ld display
=13 default_folder
=1 Window1
~| buttonenabler
= instructions
=] window1_text
=@ windowchanger
=] windowchangertext
J window1changer

Widget Type window

\Widget Name Window1
\Widget Id ID_WINDOW1
User Dala

Left 0

Top 0

\Width 854

Height 480

Border No Border
Transparent

Draw Selected

Enabled

Accepts Focus

Runtime Allocate

Normal fill WINDOW_FILL
Selected fill WINDOW_FILL
Disabled fill WINDOW_FILL
Template

Visible At Startup

Draw Function
Event Function
Wallpaper

window1_screen_event
None
Tile Wallpaper

FE Properties View -

- EJ Theme: "theme_1"

& Colors
T' Fonts
[& Pixelmaps
<> Strings
String ID English
BUTTON_DISABLED  Stay in window1
BUTTON_ENABLED GoTo Window 2
CHECKBOX_TEXT Press Me!
HELLO_WORLD Hello World -> Press anywhere to go to window 1
INSTRUCT_BUTTON Press "Goto window2" to show the next screen.
INSTRUCT_CHECKBO> Press to activate (blue), "Press me" for more.
WINDOW1 Window1
WINDOW2 Window?2
[] Press Me! STRING_1 button
STRING_2 prompt
STRING_3 checkbox
> \+} Add New String
L
Window1
U
~
~
v
L]
U
v
U
< >

Figure 62. Window1 Created
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23. Add another window to the GUIX Studio project. Right click on default_folder in the Project View and
click Insert > Window > Window as shown in Figure 63.

JG| Azure RTOS GUIX Studio 6.3.0.1 - Hello World.gxp

Project Edit Insert Configure Help

— B -4 By L] = 3 = Io = i =
[ Hello_ World
Edit Folder Properties
Cut
Copy
; Paste
5@ windov Delete
{2 win, Insert > Folder

Window 5 Window

EE Properties View Button > Vertical List

Text > Horizontal List
Indicator > Drop-down List
Menu > Line Chart

String Scroll Wheel

) Numeric Scroll Wheel
Stay i |
' Generic Scroll Wheel

Figure 63. Insert Window2
24. Setting the Properties View of Window?2.
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JG| Azure RTOS GUIX Studio 6.3.0.1 - Hello World.gxp

Project Edit Insert Configure Help
. = B ¥ By D =

1 Project View -

- & display A

) window1 changer

----- o] v
EE Properties View -

Widget Type window

Widget Name Window2

Widget Id ID_WINDOW?2

User Data

Left 0

Top 0

Width 845

Height 480

Border No Border v

Transparent []

Draw Selected ]

Enabled

Accepts Focus

Runtime Allocate []

MNormal fill WINDOW_FILL ~

Selected fill WINDOW_FILL M

Disabled fill WINDOW _FILL ~

Template ]

Visible At Startup []

Draw Function

Event Function window2_screen_event

Wallpaper MNone b

Tile Wallpaper []
Figure 64. Setting Properties of Window2
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25. Insert Prompt for Window?2. Right click from Window?2. Right click on Window2 in the Project View, then

click Insert > Text > Prompt as shown in Figure 65.

'G' Azure RTOS GUIX Studio 6.3.0.1 - Hello_World.gxp

Project Edit Insert Configure Help

= B ¥ & & B = T I z "
rh Project View -

- L display A

instructions
window1_text

..... I 5
Cut
B Properties Copy
Widget Type Paste
Widget Name Delete
Widget Id
Insert % Folder
User Data
i >
Left 0 Window
Top 0 Button >
Width 845 Text > Prompt
Height 480 Indicator > Numeric Prompt
Border 'No Border Menu > Pixelmap Prompt
Transparent Numeric Pixelmap Prompt
Draw Selected Single Line Input
Enabled Multi Line View

Accepts Focus Multi Line Input

Rich Text View

AR

Runtime Allocate

= ST

Figure 65. Insert Prompt for Window2
26. Setting Properties View of Prompt.
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JG| Azure RTOS GUIX Studio 6.3.0.1 - Hello World.gxp

Project Edit Insert Configure Help

: ] B 3 By Lp! (=
1 Project View -
: A
= Window2
window2_text| %

EH Properties View -

Widget Type prompt

Widget Name windowﬁ_te)ﬂ

Widget Id ID_WINDOWZ_TEXT

User Data
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Width 136

Height 53

Border No Border G
Transparent
Draw Selected []
Enabled []
Accepts Focus
Runtime Allocate D
Normal fill WIDGET_FILL b
Selected fill SELECTED_FILL x
Disabled fill WIDGET_FILL b
Draw Function

Event Function

String ID WINDOW?2 i
Text Window2

Font PROMPT hd
Text Align Center %
Normal Text Color TEXT b
Selected Text Color SELECTED_TEXT »
Disabled Text Color DISABLED_TEXT b
Private Text Copy

Figure 66. Setting Properties of window2_text
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27. Insert text_button for window2. Right click on Window?2 then click Insert > Button > Text Button

following Figure 67.

'G‘ Azure RTOS GUIX Studio 6.3.0.1 - Hello_World.gxp

Project Edit Insert Configure Help

instructions
; window1_text
=@ windowchanger

) B 3 B D [ 4 = Io =
rh Project View -
B : default_folder ~
= ﬁ Window1
[ buttonenabler

=] windowchangertext
- window1changer
=-- a
e wind Cut v
Copy
EE Properties Paste
Widget Type Delete
Widget Name l P " I _——
Widget Id I WVINLI VYV Z vl "
User Data
I Button > Button
Left 0 -
Text > Text Button
Top 0
Widih 845 Indicator > Multi Line Text Button
Height 480 Menu > Checkbox
Border 'No Border - | Radio Button
Transparent ] Icon Button
Draw Selected ] Pixelmap Button
Enabled Icon

Figure 67. Insert text_button for Window2
28. Set the Properties View of text_button as shown in Figure 68.
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JG| Azure RTOS GUIX Studio 6.3.0.1 - Hello World.gxp

Project Edit Insert Configure Help
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B-E windowchangertext A

W

Widget Type text_button

Widget Name window2changer
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Disabled Text Color BTN_TEXT M

Private Text Copy i

Figure 68. Setting Properties of text_button
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29. After completing inserting and configuration, window?2 looks like Figure 69.

16 Azure RTOS GUIX Studio 6.3.0.1 - Hello_World.gxp
Project Edit Insert Configure Help
L] a8 ¥ L] 0 I~ =l
=] window1_text ~
= windowchanger
== windowchangertext
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v
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Draw Function
Event Function
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Radio ]
Auto Repeat ]
String ID HELLO_WORLD ¥
Text Hello World - Press anywhere to go
Font BOLD_24 i
Text Align Center s
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Disabled Text Color BTN_TEXT b
Private Text Copy O

Hello World -> Press anywhere to go to window 1

L T] > Ed @
Theme: "theme_1"

& Colors

T Fonts

[&] Pixelmaps
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O 16x16  CHECKBOX_OFF 1KB

16%16 CHECKBOX ON 1KB
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=2 Custom
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Figure 69. Window2
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30. Click on drop-down list Pixelmaps, double-click on “CHECKBOX_OFF” and a new window will pop up.

Uncheck Compress Output then click Save. Do the same for CHECKBOX_ON.

I Pixelmaps
View Dims Name
System

O [16x16 CHECKBOX_OFF

16x16 CHECKBOX_ON

1KB

1KB

16x16 RADIO_OFF
& [16x16 RADIO_ON

Custom

«/> Strings

String ID English
BUTTON_DISABLED  Stay in window1
CHECKBOX_TEXT Press Mel
INSTRUCTION_CHECKI Press to activate (blue), "Pre

Stay in window1 [] Press Me!

WINDOW1 Window1

[ Edit Pixelmap(s)

Source Image Path

[ ] Spedify Output File

Output Format

[ ]rRaw Format Use display default
|[_]Compress Output |

[Jinclude Alpha Channel

[ ]Dither

0 "Compress Output" option will be reset if the compressed data size is bigger than the original.

- Cancel

] <Project Relative Path> browse...

1KB

1KB

ar

Save

Figure 70. Set Up Pixelmap
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31. Now you can click on the Project drop down list, Save Project, and Generate All Output Files. You
completed the process of creating and exporting GUIX Hello World into the project.

t@l Azure RTOS GUIX Studio 6.3.0.1 - Hello_World.gxp - O e
Project. I Edit Insert Configure Help
New Project Cri+N | ® = K G G 2 Q @ M+ X @
Open Project Cl+0 E) Theme: "theme_1"
cus
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Save Project As Shift+Ctrl+S
Close Project T Fonts
Import Project El Pixelmaps
fecsnt Brojects it View Dims  Name
Generate All Output Files [ System
Generate Resource Files
i [0 16x16  CHECKBOX_OFF 1KB
Generate Specification Files
Exit Alt+F4 - 16x16  CHECKBOX_ON KB
Widget Type ey 16x16 RADIO_OFF 1KB
Widget Name Window1 ® |16x16 RADIO_ON 1KB
Widget Id ID_WINDOW1
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T 0 i i
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Width 854
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Height 480
Border No Border = INSTRUCT_CHECKBQ? Press to activate (blue), "Press me" for more.
BUTTON_DISABLED  Stay in window1
Transparent D Window1
Draw Sclodied O WINDOWH Window1
Enabled HELLO_WORLD Hello World -> Press anywhere to go to window 1
Accepts Focus WINDOW?2 Window2
Runtime Allocate ] BUTTON_ENABLED  GoTo Window 2
Normal fill WINDOW_FILL b r
= INSTRUCT_BUTTON Press "Goto window2" to show the next screen.
Selected fill WINDOW_FILL ¥ —
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Draw Function
Event Function window1_screen_event
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Figure 71. Save and Generate Project

32. Make sure the project is active and click to build the project. It may take a long time to finish building an
Azure RTOS/GUIX project on your PC. Project ra8d1_guix_hello_world should be built with no errors

or warnings.
. — — I e — ; - N
[#7 Problems | & Console X @ Smart Browser &} Smart Manual‘ x| 4 ¢ 9| LH BB x f.El‘ ME-{~-=0

CDT Build Console [mipi_ek_ra8d1_guix_hello_world]

Building tile: ../ra/tsp/src/bsp/mcu/all/bsp_rom_registers.c T
Building file: ../ra/fsp/src/bsp/mcu/all/bsp_sbrk.c

Building file: ../ra/fsp/src/bsp/mcu/all/bsp_security.c

Building file: ../ra/fsp/src/bsp/cmsis/Device/RENESAS/Source/startup.c

Building file: ../ra/fsp/src/bsp/cmsis/Device/RENESAS/Source/system.c

Building file: ../ra/board/ra8dl_ek/board_init.c

Building file: ../ra/board/ra8dl_ek/board_leds.c

Building file: ../ra/board/ra8dl_ek/board_sdram.c

Building target: mipi_ek_ra8dl_guix_hello_world.elf

arm-none-eabi-objcopy -0 srec "mipi_ek_ra8dl_guix_hello_world.elf" "mipi_ek_ra8dl_guix_hello_world.srec”
arm-none-eabi-size --format=berkeley "mipi_ek_ra8dl_guix_hello_world.elf"

text data bss dec hex filename
584824 560 3330848 3916232 3bclc8 mipi_ek_ra8dl_guix_hello_world.elf
21:40:15 Build Finished. @ errors, 8 warnings. (took 5m:13s.124ms) -
Figure 72. Built The Code
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33. Using the Micro USB cable, connect to J10 on EK-RA8D1 board and the other end to your PC.
Download and run the “mipi_ek_ra8d1_guix_hello_world” project.

Stay in window1 [] Press Me!

Window1

Figure 73. Window1 Display
6. Overview of Fully Functional Project

6.1 Overview

In this section, you will import and run the complete “mipi_ek ra8dl_guix hello_world” project. You
can enable or disable the check box function. The text on the button, which is “Stay in window1” or “Go to
Window 27, will be updated. Once you press the button, the screen will change from window1 to window?2.
Follow the text message on the screen; you can change from window?2 back to window1.

6.2 Procedural Steps

1. You can try the provided project “mipi_ek_ra8dl_guix hello_world” for the full function
application. Use the Rename & Import Existing C/C++ Project into Workspace feature of the Import
menu to do so since you already had a project with the same in the workspace.
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File Edit Mavigate Search Project Renesas Views R
Mew Alt+5hift+N >
Open File...

) Open Projects from File System...
Recent Files »
Close Editor Ctrl+W
Close All Editors Ctrl+Shift+W
Save Ctrl+S
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Save All Ctrl+Shift+5
Revert
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Refresh F5
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Print... Ctrl+P

E Import... | Import h

7 Export..
Properties Alt+Enter
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Exit

Q Import O
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Rename and Import and Existing C/C++ Project into the workspace

Select an import wizard:
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v % General
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(4 cMsIS Pack
1= Existing Projects into Workspace
[} File System
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|} Projects from Folder or Archive
I 1= Rename & Import Existing C/C++ Project into Workspace I
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@ Import O X

Rename & Import Project |
Select a directory to search for existing Eclipse projects. g A
Project name: | mipi_ek_ra8d1_guix_hello_world I

Use default location
C\WorkSpace\EK_RA8D1\mipi_ek ra8d1_guix_hello_world_ Browse...
Create Directory for Project

default

Import from:

(® Select root directory: | C:\WorkSpace\EK_RA8D 1\mipi_ek_ra8d1_guix_hello_wor ~

() Select archive file: Browse...

Projects:

mipi_ek_ra8d1_guix_hello_world (C:\WorkSpace\EK_RA8BD 1\mipi_sk_ra8d1_guix_hello_world)

Options
[ Keep build configuration output folders

)

< Back Next > Finish Cancel

Figure 74. Import Existing Project
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7. Website and Support

Visit the following URLSs to learn about key elements of the RA family, download components and related
documentation, and get support:

RA Product Information renesas.com/ra

RA Product Support Forum renesas.com/ra/forum

RA Flexible Software Package renesas.com/FSP

Renesas Support renesas.com/support
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General Precautions in the Handling of Microprocessing Unit and Microcontroller
Unit Products

The following usage notes are applicable to all Microprocessing unit and Microcontroller unit products from Renesas. For detailed usage notes on the
products covered by this document, refer to the relevant sections of the document as well as any technical updates that have been issued for the products.
1. Precaution against Electrostatic Discharge (ESD)
A strong electrical field, when exposed to a CMOS device, can cause destruction of the gate oxide and ultimately degrade the device operation. Steps
must be taken to stop the generation of static electricity as much as possible, and quickly dissipate it when it occurs. Environmental control must be
adequate. When it is dry, a humidifier should be used. This is recommended to avoid using insulators that can easily build up static electricity.
Semiconductor devices must be stored and transported in an anti-static container, static shielding bag or conductive material. All test and
measurement tools including work benches and floors must be grounded. The operator must also be grounded using a wrist strap. Semiconductor

devices must not be touched with bare hands. Similar precautions must be taken for printed circuit boards with mounted semiconductor devices.
2. Processing at power-on

The state of the product is undefined at the time when power is supplied. The states of internal circuits in the LSI are indeterminate and the states of
register settings and pins are undefined at the time when power is supplied. In a finished product where the reset signal is applied to the external
reset pin, the states of pins are not guaranteed from the time when power is supplied until the reset process is completed. In a similar way, the states
of pins in a product that is reset by an on-chip power-on reset function are not guaranteed from the time when power is supplied until the power

reaches the level at which resetting is specified.
3. Input of signal during power-off state

Do not input signals or an 1/0 pull-up power supply while the device is powered off. The current injection that results from input of such a signal or /0
pull-up power supply may cause malfunction and the abnormal current that passes in the device at this time may cause degradation of internal

elements. Follow the guideline for input signal during power-off state as described in your product documentation.
4. Handling of unused pins

Handle unused pins in accordance with the directions given under handling of unused pins in the manual. The input pins of CMOS products are
generally in the high-impedance state. In operation with an unused pin in the open-circuit state, extra electromagnetic noise is induced in the vicinity
of the LSI, an associated shoot-through current flows internally, and malfunctions occur due to the false recognition of the pin state as an input signal

become possible.
5. Clock signals

After applying a reset, only release the reset line after the operating clock signal becomes stable. When switching the clock signal during program
execution, wait until the target clock signal is stabilized. When the clock signal is generated with an external resonator or from an external oscillator
during a reset, ensure that the reset line is only released after full stabilization of the clock signal. Additionally, when switching to a clock signal

produced with an external resonator or by an external oscillator while program execution is in progress, wait until the target clock signal is stable.
6. Voltage application waveform at input pin

Waveform distortion due to input noise or a reflected wave may cause malfunction. If the input of the CMOS device stays in the area between Vi
(Max.) and Vix (Min.) due to noise, for example, the device may malfunction. Take care to prevent chattering noise from entering the device when the

input level is fixed, and also in the transition period when the input level passes through the area between ViL (Max.) and Vi (Min.).
7. Prohibition of access to reserved addresses

Access to reserved addresses is prohibited. The reserved addresses are provided for possible future expansion of functions. Do not access these

addresses as the correct operation of the LSl is not guaranteed.
8. Differences between products

Before changing from one product to another, for example to a product with a different part number, confirm that the change will not lead to problems.
The characteristics of a microprocessing unit or microcontroller unit products in the same group but having a different part number might differ in
terms of internal memory capacity, layout pattern, and other factors, which can affect the ranges of electrical characteristics, such as characteristic
values, operating margins, immunity to noise, and amount of radiated noise. When changing to a product with a different part number, implement a

system-evaluation test for the given product.



Notice

1.

10.

11.

12.

13.
14.

(Note1)

Descriptions of circuits, software and other related information in this document are provided only to illustrate the operation of semiconductor products
and application examples. You are fully responsible for the incorporation or any other use of the circuits, software, and information in the design of your
product or system. Renesas Electronics disclaims any and all liability for any losses and damages incurred by you or third parties arising from the use
of these circuits, software, or information.
Renesas Electronics hereby expressly disclaims any warranties against and liability for infringement or any other claims involving patents, copyrights,
or other intellectual property rights of third parties, by or arising from the use of Renesas Electronics products or technical information described in this
document, including but not limited to, the product data, drawings, charts, programs, algorithms, and application examples.
No license, express, implied or otherwise, is granted hereby under any patents, copyrights or other intellectual property rights of Renesas Electronics
or others.
You shall be responsible for determining what licenses are required from any third parties, and obtaining such licenses for the lawful import, export,
manufacture, sales, utilization, distribution or other disposal of any products incorporating Renesas Electronics products, if required.
You shall not alter, modify, copy, or reverse engineer any Renesas Electronics product, whether in whole or in part. Renesas Electronics disclaims any
and all liability for any losses or damages incurred by you or third parties arising from such alteration, modification, copying or reverse engineering.
Renesas Electronics products are classified according to the following two quality grades: “Standard” and “High Quality”. The intended applications for
each Renesas Electronics product depends on the product’s quality grade, as indicated below.

"Standard": Computers; office equipment; communications equipment; test and measurement equipment; audio and visual equipment; home

electronic appliances; machine tools; personal electronic equipment; industrial robots; etc.
"High Quality": Transportation equipment (automobiles, trains, ships, etc.); traffic control (traffic lights); large-scale communication equipment; key
financial terminal systems; safety control equipment; etc.

Unless expressly designated as a high reliability product or a product for harsh environments in a Renesas Electronics data sheet or other Renesas
Electronics document, Renesas Electronics products are not intended or authorized for use in products or systems that may pose a direct threat to
human life or bodily injury (artificial life support devices or systems; surgical implantations; etc.), or may cause serious property damage (space
system; undersea repeaters; nuclear power control systems; aircraft control systems; key plant systems; military equipment; etc.). Renesas Electronics
disclaims any and all liability for any damages or losses incurred by you or any third parties arising from the use of any Renesas Electronics product
that is inconsistent with any Renesas Electronics data sheet, user's manual or other Renesas Electronics document.
No semiconductor product is absolutely secure. Notwithstanding any security measures or features that may be implemented in Renesas Electronics
hardware or software products, Renesas Electronics shall have absolutely no liability arising out of any vulnerability or security breach, including but
not limited to any unauthorized access to or use of a Renesas Electronics product or a system that uses a Renesas Electronics product. RENESAS
ELECTRONICS DOES NOT WARRANT OR GUARANTEE THAT RENESAS ELECTRONICS PRODUCTS, OR ANY SYSTEMS CREATED USING
RENESAS ELECTRONICS PRODUCTS WILL BE INVULNERABLE OR FREE FROM CORRUPTION, ATTACK, VIRUSES, INTERFERENCE,
HACKING, DATA LOSS OR THEFT, OR OTHER SECURITY INTRUSION (“Vulnerability Issues”). RENESAS ELECTRONICS DISCLAIMS ANY AND
ALL RESPONSIBILITY OR LIABILITY ARISING FROM OR RELATED TO ANY VULNERABILITY ISSUES. FURTHERMORE, TO THE EXTENT
PERMITTED BY APPLICABLE LAW, RENESAS ELECTRONICS DISCLAIMS ANY AND ALL WARRANTIES, EXPRESS OR IMPLIED, WITH
RESPECT TO THIS DOCUMENT AND ANY RELATED OR ACCOMPANYING SOFTWARE OR HARDWARE, INCLUDING BUT NOT LIMITED TO
THE IMPLIED WARRANTIES OF MERCHANTABILITY, OR FITNESS FOR A PARTICULAR PURPOSE.
When using Renesas Electronics products, refer to the latest product information (data sheets, user's manuals, application notes, “General Notes for
Handling and Using Semiconductor Devices” in the reliability handbook, etc.), and ensure that usage conditions are within the ranges specified by
Renesas Electronics with respect to maximum ratings, operating power supply voltage range, heat dissipation characteristics, installation, etc. Renesas
Electronics disclaims any and all liability for any malfunctions, failure or accident arising out of the use of Renesas Electronics products outside of such
specified ranges.
Although Renesas Electronics endeavors to improve the quality and reliability of Renesas Electronics products, semiconductor products have specific
characteristics, such as the occurrence of failure at a certain rate and malfunctions under certain use conditions. Unless designated as a high reliability
product or a product for harsh environments in a Renesas Electronics data sheet or other Renesas Electronics document, Renesas Electronics
products are not subject to radiation resistance design. You are responsible for implementing safety measures to guard against the possibility of bodily
injury, injury or damage caused by fire, and/or danger to the public in the event of a failure or malfunction of Renesas Electronics products, such as
safety design for hardware and software, including but not limited to redundancy, fire control and malfunction prevention, appropriate treatment for
aging degradation or any other appropriate measures. Because the evaluation of microcomputer software alone is very difficult and impractical, you are
responsible for evaluating the safety of the final products or systems manufactured by you.
Please contact a Renesas Electronics sales office for details as to environmental matters such as the environmental compatibility of each Renesas
Electronics product. You are responsible for carefully and sufficiently investigating applicable laws and regulations that regulate the inclusion or use of
controlled substances, including without limitation, the EU RoHS Directive, and using Renesas Electronics products in compliance with all these
applicable laws and regulations. Renesas Electronics disclaims any and all liability for damages or losses occurring as a result of your noncompliance
with applicable laws and regulations.
Renesas Electronics products and technologies shall not be used for or incorporated into any products or systems whose manufacture, use, or sale is
prohibited under any applicable domestic or foreign laws or regulations. You shall comply with any applicable export control laws and regulations
promulgated and administered by the governments of any countries asserting jurisdiction over the parties or transactions.
It is the responsibility of the buyer or distributor of Renesas Electronics products, or any other party who distributes, disposes of, or otherwise sells or
transfers the product to a third party, to notify such third party in advance of the contents and conditions set forth in this document.
This document shall not be reprinted, reproduced or duplicated in any form, in whole or in part, without prior written consent of Renesas Electronics.
Please contact a Renesas Electronics sales office if you have any questions regarding the information contained in this document or Renesas
Electronics products.

“Renesas Electronics” as used in this document means Renesas Electronics Corporation and also includes its directly or indirectly controlled
subsidiaries.

(Note2)

Corporate Headquarters
TOYOSU FORESIA, 3-2-24 Toyosu,
Koto-ku, Tokyo 135-0061, Japan

www.renesas.com

Trademarks

Renesas and the Renesas logo are trademarks of Renesas Electronics
Corporation. All trademarks and registered trademarks are the property
of their respective owners.

“Renesas Electronics product(s)” means any product developed or manufactured by or for Renesas Electronics.

(Rev.5.0-1 October 2020)

Contact information

For further information on a product, technology, the most up-to-date
version of a document, or your nearest sales office, please visit:
www.renesas.com/contact/.

© 2023 Renesas Electronics Corporation. All rights reserved.
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